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Introduction

This tutorial teaches you how to create a simple e-business customer inquiry
application that uses a Web-based front end to communicate with the business
logic written in ILE RPG residing on an iSeries " server. While creating a browser
user interface, you will learn how to use the iSeries Web Interaction wizard to
generate input and output JSP files as well as Page Designer to enhance the input
and output Web pages. You will also add iSeries Web components to your pages,
for example, Web equivalents of iSeries command keys, input fields that accept
only particular types of data, or output fields such as subfile names. You will then
learn how to run the application in the WebSphere® Test Environment that is part
of the product.

Prerequisites

In order to complete this tutorial end to end, you should already have working
knowledge of the following:

* Basic Microsoft® Windows® operations such as working with the desktop and
basic mouse operations such as opening folders and performing drag-and-drop
operations.

* How Web applications work.

* How to use a browser to navigate the Internet.

It is also useful, but not necessary, for you to have basic knowledge of the
following:

* DDS

* Servlets and Java' Server Pages (to understand the generated output of the Web
Interaction wizard)

The file(s) required for this tutorial are available for download at
http:/ /ibm.com /software/awdtools/wdt400/library.

Time required

To complete the modules of this tutorial, you will need approximately 3 hours and
5 minutes.

Learning objectives
The tutorial is broken into 9 modules, each with its own learning objectives. You

can choose to complete one or all of the modules. Each module contains several
exercises that must be completed in order for the tutorial to work properly.

Chapter 1, “Module 1. Introducing the Web customer inquiry application,” on page]
1] teaches you about the completed e-business customer inquiry application that
you will build in this tutorial. In this module, you will:

* View a concept diagram of the Web development tools process
* Recognize the capabilities of the iSeries Web tools
* View the finished Web customer inquiry application

© Copyright IBM Corp. 2001, 2005 v
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[Chapter 2, “Module 2. Creating an RPG program,” on page 7| teaches you how to
use the Remote System Explorer perspective to edit and compile an iSeries
program that will be invoked by the Web application to get data from the iSeries.
In this module, you will:

* Start the product

* Set the default workspace

* Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Edit an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

* Display a format line

* Compile a program object

Chapter 3, “Module 3. Creating the RPG service program for your Web application|
(optional),” on page 23| teaches you how to use the Remote System Explorer
perspective to edit and compile an iSeries service program that will be invoked by
the Web application to get data from the iSeries. In this module, you will:

* Start the product

* Set the default workspace

¢ Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Edit an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

* Display a format line

* Compile a service program object

[Chapter 4, “Module 4. Creating a Web project,” on page 41| teaches you about the
Web perspective and the tools in this perspective to help you create a Web project
to contain your Web application files and to supply the information which the
iSeries server will use for serving business information for this Web application. In
this module, you will:

* Access tools and views for iSeries Web application development
* Know the difference between a static Web project and a dynamic Web project
* Set up a dynamic Web project

* Define where the RPG program or service program resides on an iSeries server

[Chapter 5, “Module 5. Creating a Web application,” on page 55 teaches you how to
create a Web interaction to use an input and output page, and to create the servlet
to invoke an RPG program to get data from the iSeries database. You will also
learn how to visualize the flow structure of your Web application using the Web
Diagram editor. In this module, you will:

¢ Start the Web Interaction wizard

¢ Create an input page that invokes the interaction

Development Studio Client: iSeries Web tools



* Create an output page that displays the results of the interaction

* Get the program interface definitions

* Specify the input and output parameters

* Specify the input parameters to show on the input page

* Specify what data to show on the output page

* Specify what will happen when an incorrect customer number is entered
¢ Change the background color of the output page

* Make sure the customer number field is read only

* Know what Struts is all about

¢ View the flow structure of a Struts-based Web application

[Chapter 6, “Module 6. Running the Web application,” on page 89| teaches you how
to run the Web application in the WebSphere Test Environment. You also learn
about the WebSphere Test Environment. In this module, you will:

¢ Check the Web perspective is open

* Locate input page of the Web application

* Invoke the Web application to run in the WebSphere Test Environment
* Test the Web application

[Chapter 7, “Module 7. Debugging a Web application,” on page 95| teaches you how
to set up the debug environment, use a service entry point, add and remove
breakpoints, display a variable, and view the call stack. In this module, you will:

* Recognize the features of the iSeries Integrated Debugger
* Set breakpoints
* Monitor an expression

* Expand a thread to show every program, module, procedure and method on the
call stack at the current execution point

* Run the program to termination

[Chapter 8, “Module 8. Adding an error page,” on page 103| teaches you how to
create an informative error page for customers when an incorrect customer number
is entered.

* Create an error page using Page Designer
¢ Change the Web interaction to use the new error page
¢ View the result of adding flow control to the Web application

[Chapter 9, “Module 9. Enhancing the input page using Web tools,” on page 115|
explains how to add color and some pictures to make the input page of the Web
application more attractive. You will learn how to use the Page Designer tool and
some other related Web tools. In this module, you will:

* Locate the Web application input page and start Page Designer
* View the title of the input page

e Add a style to the input page

* Preview the new style for the input page

 Start WebArt Designer

* Create a logo

* Resize the logo

* Save the object as a WebArt object

Introduction Vil



* Save the object for a Web page

* Place the object on the Design page

e Add a company name to the input page
* Add an image to the input page

* Add a marquee to the input page

* Apply color to certain areas of text

When you are ready, begin |[Chapter 1, “Module 1. Introducing the Web customer|
linquiry application,” on page 1.
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Chapter 1. Module 1. Introducing the Web customer inquiry
application

This module teaches you about the Web customer inquiry application that you will
build in this tutorial. You will also learn about the iSeries Web tools included with
the product.

In this module, you will:

¢ View a concept diagram of the Web development tools process
* Recognize the capabilities of the iSeries Web tools

¢ View the finished Web customer inquiry application

Requirement: Before beginning this module, you should have the prerequisite
knowledge outlined in [“Introduction” on page v |

Exercises

The exercises within this module must be completed in order:

* [“Introducing iSeries Web Application Development”]

+ |“Introducing the Web customer inquiry application” on page 2|

Time required

This module will take approximately 5 minutes to complete.

Introducing iSeries Web Application Development

With the product you can make your iSeries applications and data accessible
beyond the green-screen interface. You can create a new Web interface that
connects directly to your program’s input and output parameters.

You can create interactive Web pages using Web development tools. You use the
Web Interaction wizard to define how your pages interact with one or more ILE or
non-ILE applications. This wizard generates Java Action classes and JSP files for
use with data from HTML forms. When the end user enters data in a form, the
input becomes data to your ILE and non-ILE programs, and the output from the
programs is formatted for the Web. Your ILE and non-ILE logic can be separated
into different programs for each stage of input and output (known as a Web
interaction), or can be a single service program with entry points to handle each
Web interaction. The following diagram illustrates the Web development tools
process:
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I ] Web Page | Web Page
« input value = output value

Action classes |

. RPG program J

(input value --> input parameter)

You can easily customize your HTML and JSP files using the editing tools in Web
development tools. You can use these tools to create and update input forms,
change the appearance or placement of blocks of text, and add backgrounds and
images to your pages. The iSeries-specific Web components help you create Web
versions of your input and output pages with the same kinds of input validation,
output formatting, and subfile controls that native DDS screens provide. You do
not need a detailed knowledge of HTML or Java to accomplish these tasks.

You have an easy test mechanism for your Web-enabled applications. You can
easily run your program in the WebSphere test environment of the workbench,
quickly make changes, and retest, rather than redeploy your application every time
you want to verify functions. When you are finished, you can package and deploy
your Web applications as J2EE-based Web archive (WAR) and Enterprise Archive
(EAR) files, and then install them in a WebSphere Application Server.

You have looked at the concept diagram of the Web development tools process and
can recognize the capabilities of the iSeries Web tools and now you are ready to
begin [‘Introducing the Web customer inquiry application.”|

Introducing the Web customer inquiry application

Before you begin, you must complete [“Introducing iSeries Web Application|
[Development” on page 1

By the end of this tutorial you will have created a simple e-business customer
inquiry application that uses a Web-based front-end to communicate with RPG
business logic residing on an iSeries server. You will first create the RPG program
or service program for your Web application. You will then create a Web project
and invoke the Web Interaction wizard to create the input and output pages and to
create the servlet to invoke the RPG program or service program to get data from
the iSeries database. Next, you will run the application in the local test
environment on your workstation. You will also create an informative error page
for when a customer enters an incorrect customer number.

Here is what the finished e-business customer inquiry application looks like.

After the WebSphere server has started, your Web application Customer Inquiry
input page (inquiry,jsp) will display in the workbench browser:
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Customer Inquiry
Enter customer number: |0010100|

Reset

Daone

=
—_—

When you enter a customer number and click the Submit push button, the
Customer Details output page (result.jsp) appears.

=]
Customer Details
Customer Number: 0010100
Customer MName. Meridien Electronics Limited
Representative Number: 43443
Contact Alfredo Bayonne
Phone Number: 206-865-4027
Fax Number: 206-865-4037
Address: 10423 S E. 30th Place
City: Bellevue, WA
Country: USA.
Zip: 98007
[ submit | Reset
=
Dane [Es——

Next, you click the ﬂ Back button in the browser to return to the Customer
Inquiry input page. Here you enter an incorrect customer number and click

Submit.
] = |
Customer Inquiry
Enter customer number | 9999
[Submit | Reset
]
Dane %

Chapter 1. Module 1. Introducing the Web customer inquiry application
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An error message appears.

Customer Inquiry
Enter customer number (9999
Submit | Reset

Customer number 9999 not valid

—

%

You then add a new output error page to improve the message information so that
if a wrong customer number is entered,

= |
Customer Inquiry
Enter customer number | 9999
]
Dane

an error page opens instead of a message.

=
Sorry, there 13 no record for that customer number.
Please check the number and try agam,
7
Done

Module recap

You have completed [Chapter 1, “Module 1. Introducing the Web customer inquiry|
[application,” on page 1] You have learned how to:

* View a concept diagram of the Web development tools process
* Recognize the capabilities of the iSeries Web tools
* View the finished Web customer inquiry application

Now that you have this introductory knowledge of the product iSeries Web application

development, you can continue with [Chapter 2, “Module 2. Creating an RPG program,”|
|on page 5] if you want to work with an RPG program or|[Chapter 3, “Module 3. Creating]

[[the RPG service program for your Web application (optional),” on page 23| if you want
|to work with an RPG service program.
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Chapter 2. Module 2. Creating an RPG program

This module teaches you how to create the iSeries program that you will be using
for your Web application using the Remote System Explorer perspective. Remote
System Explorer provides a PDM like environment but with a GUI interface, and
full integration with all iSeries programmer tools in the workbench.

In this module, you will:

e Start the product

* Set the default workspace

* Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

e Display a format line

¢ Edit an RPG source member with the Remote Systems LPEX Editor
* Compile a program object

If you want to work with a procedure in a service program instead, go to [Chapter 3,
[“Module 3. Creating the RPG service program for your Web application (optional),” on|

|Bage 23|

If you haven’t used the LPEX editor before, you may want to spend some time
trying some LPEX editor features.

Exercises

The exercises in this module must be completed in order:

+ [“Exercise 2.1: Starting the product” on page 8|

+ |“Exercise 2.2: Opening the Remote System Explorer perspective” on page 9|

* [“Exercise 2.3: Creating a connection to the iSeries server” on page 11|

» [“Exercise 2.4: Finding an iSeries source member” on page 13|

* |“Exercise 2.5: Opening a source member for edit” on page 14|

* |“Exercise 2.6: Reviewing Remote System LPEX Editor features” on page 15|

* |“Exercise 2.7: Editing an RPG source member and creating a *PGM object” on|

page 18|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 2.1: Starting the product

Now go ahead and start the product.

On your desktop taskbar:

'E IEM WebSphere Development Studio Client For iSeries W60 M@  WebSphere Development Studio Client for iSeries

1. Click Start > Programs > IBM® Rational® > IBM WebSphere Development
Studio Client for iSeries V6.0 > WebSphere Development Studio Client for
iSeries
A dialog for workspace selection will appear asking you for the workspace

location, unless you used the product before and selected not to show this
dialog again.

workspace Launcher x

Select a workspace

1BM Rational Software Development Platform stores vour projects in a directory called a workspace.
Select the workspace directory to use for this session.

Workspace: | Ci\Documents and Settings\Administratorl18M\rationalsdps, Blwsslabixx ﬂ Browse, .. |

I Use this as the default and do not ask again

The workspace contains all the information about your Development Studio

projects. You can accept the default or store the work related to this tutorial, in
a separate workspace.

2. To name the directory of the workspace as shown above, use the directory
name WSSLABxx.

3. Click OK.

After a few moments of loading, the workbench opens, and the initial window
of the product appears on your desktop.
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You have just started the product, set the default workspace and now you are
ready to begin [‘Exercise 2.2: Opening the Remote System Explorer perspective.”|

Exercise 2.2: Opening the Remote System Explorer perspective

Before you begin, you must complete [“Exercise 2.1: Starting the product” on page|

Check if the window title bar says: Remote System Explorer. If it does all you need
to do is close the Welcome view.

@& Remote System Explorer - IBM Rational Software Development Platform

File Edt MNavigate Search Project Run Window Help

Skip the next steps and go directly to [“Exercise 2.3: Creating a connection to the|
iSeries server” on page 11)

To open the Remote System Explorer perspective:

Chapter 2. Module 2. Creating an RPG program 9



1. In the workbench, check whether you have the Remote System Explorer
perspective already open. Look for the icon in the taskbar of the workbench.

2. If you cannot see the icon because the Welcome view is open, click X to close
the Welcome view.

3. If you see it click the @ RSE icon.

(o x|
File Edit Mavigate Search Project Run  Window Help

9+ 10 3% -0 - Q- EA- e

( |[B= outie 52 =0
‘ Ptgl.tllne is not available.

4. Otherwise, click Window > Open Perspective > Remote System Explorer on
the workbench menu.

The Remote System Explorer perspective opens.
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Fil= Edit Mavigate Search Project Run Window Help

5 - |45+ 0 - Q- |5 | Eremote syste..
l . = =

2% outline 52 ==
A{Eutllns is not available.

@ Windows. ..
= inux...
-\ Power Linux...
G i Uniie. .
1§, AIK.
EI E Local...

= Ef Local

[ BRemcte ... 83 TaskstiSerles...!”l =5)

. = =
Root Connections = | < | B 2
Kame ] Parent profile I Femate
3 Local Private Local
Elproperties 3\ [E 2 = » =0
Property l Value |
Marne Mew Connection
Mumber of chi... 7
Tvpe An expandable prompt fo...
| J |

|| Anexpandable prompt F...ection: New Connection |

You have checked that the Remote System Explorer perspective is open and now
you are ready to begin [“Exercise 2.3: Creating a connection to the iSeries server.”|

Exercise 2.3: Creating a connection to the iSeries server

Before you begin, you must complete [“Exercise 2.2: Opening the Remote System|
[Explorer perspective” on page 9.

1. Click the plus sign + beside iSeries under New Connection in the Remote
Systems view.

2. Accept the default profile name.
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x

Name personal profile

Uniquely name user profile | l

Welcome to Remate Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members. You wil
decide for each new connection whether it is owned by the team profile or your
prafile,

Profile; | msteckh7tp

< Back [ Finish Cancel

3. Click Next.

x|
Remote iSeries System Connection
Define connection information | l
Parent profile: |msted<h?tp j
Connection namef | s400a ‘\
Haost name: 54003 j

Descriptions |

¥ Werify host name

<pack | mext> [[CFnsh) | cancel |

In this exercise s400a is used as the name for the iSeries server. You will need
to use the name or IP address of your particular iSeries server.

4. Type a host name, for example, s400a in the Host name field.

o

The Connection name field will be filled automatically with the same entry.
6. Click Finish.

Your new connection appears in the Remote Systems view and you are ready
to work with objects on this iSeries system.

You have set up a new connection to an iSeries server and now you are ready to
begin [“Exercise 2.4: Finding an iSeries source member” on page 13/
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Exercise 2.4: Finding an iSeries source member

Before you begin, you must complete |“Exercise 2.3: Creating a connection to the

iSeries server” on page 11|

You will see a list of libraries under Library list in the Remote Systems view. Now

you locate the source you want to edit.

To find an iSeries source member:

£ g | 2| B%)

15

1]

-
[#- 47 MNew Connection -
- Local
5_4IJIZIa
iSeties Objects

-2, work with lbraries. .
& work with objects...

fﬂ Work Mth members..

L+J ﬁl QSYSZ "1|b prod-sys
I i} QHLPSYS. *ib prod Sys

I:{ -3 DEMORE "‘pgm rpals

- E] GETDASOL. *pom.rpgle
2 :) GETDASOLY. *pgm.rpgl
[#-[F] GETDATA.*pam.rpgle

[+~ ] GETDSSOLC, *pam.chlle
[~ [#] READDTAQ.*pgm.rpale
[+~ WRTDTAQ. *pgm.rpgle
[ 32 GETDATASC *srvpgma
¥ 2] GETDSSOL. *srvpam.rp
[#-pa] ORDENTR. *srvpam.rpe
e ] WDSCSRY, *srvpgmm, o

A T AT Ase *..].J.‘I-

Note: If you don’t see WSSLABxx in your library list, then you need to add the
library. You can right-click the Library list and click Add Library List Entry
from the pop-up menu to add WSSLABxx to your library list.

oo bd =~

Expand your iSeries connections.

Expand iSeries Objects by clicking the plus sign + beside it.

Expand Library List.
Expand the library WSSLABxx.

You will see all objects in this library.

Expand the source file QRPGLESRC.
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L]

CralEs
] CUSTOMLL *file.Jf -
() CUSTOMLI. *file.If
] CUSTOMS1, *file. F
o) CUSTOMSZ, *File, IF
1] CUSTOMS3, *file. F
(] CUSTOMS4, *file.IF
[ EVFEVENT.*file.pf-dta
=5 INVPRINT *file.prtf
& PRODDTL.*file,pf-dta
[F] PRODINY *file.pf-dta
T3 PRODLIST. *file.pf-dta
& PRODSHOW. *file. pf-dta
I3 PRODUCT *file.pf-dta
] PRODUCTJF. *file. I
E) QCBLLESRC. *File.pf-sre

&-EE-E-EE-E

[
o8|

[}y GETDASOLZ.rpale
[y GETDATA.rpale
~-[Py GETDATAS.rpgle
.y GETDSSOL rpgle
L[y SUBFILEPRZ.rpgle
-y WDSCSRY.rpgle

Py WDSCSRYZ.rpale =

i

1 [Ele mmmes menon g . o6 -

‘.il H

6. Scroll down to the source members in the expanded list.

You have located an RPG source member you want to edit and now you are ready
to begin [“Exercise 2.5: Opening a source member for edit.”|

Exercise 2.5: Opening a source member for edit

Before you begin, you must complete [“Exercise 2.4: Finding an iSeries source|
[member” on page 13/

A shell source member is provided for you to use.

To edit a source member:
1. Right-click member GETDATA.
2. Click Open with > Remote Systems LPEX Editor on the pop-up menu.
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0] CUSTOML1, *File.IF
0] CUSTOMLS *file.If
1] CUSTOMSY , *file IF
L] CUSTOMSZ, *file IF
-] CUSTOMS3, *file If
-] CUSTOMS4, *file, I
-5 EVFEVENT *file pf-dta
4] INVPRINT *file.prtf
#-F PRODDTL,*file.pf-dta
#-[F PRODINY.*fle.pf-dta
@[ PRODLIST. *file. pf-dta
#-[E PRODSHOW, *file, pf-dta
#1-[F PRODUCT *file.pf-dta
4] PRODUCTIF *file. I
1-El QCBLLESRC. *file.pf-src
-l QDDSSRC, *file.pf-src
=1-El) QRPGLESRC. *file, pf-src
: 0y GETDASOL.rpgle
My GETDASCLZ.rpgle
o) GETDATA.rpdle

2y GETDATAS.poh G070

4 CODE Editor X | Browse With '

The Editor window opens and you are ready to write your program.

Note: You can also double-click on a member to open the Remote Systems

LPEX editor.

You have opened an RPG source member for edit and now you are ready to begin

[“Exercise 2.6: Reviewing Remote System LPEX Editor features.”|

Before you work with the RPG program source, if you have not worked with the

Editor features.”

Remote Sistems LPEX editor; go to [“Exercise 2.6: Reviewing Remote System LPEX|

If you already know the LPEX editor, then you are ready to write the RPG program; go

to [“Exercise 2.7: Editing an RPG source member and creating a *PGM object” on pagel

Exercise 2.6: Reviewing Remote System LPEX Editor features

Before you begin, you must complete [“Exercise 2.5: Opening a source member for|

fedit” on page 14

Before you start, here are some useful tips on using the LPEX editor. Let’s look at
some of the features of the LPEX editor, so you can later easily find your way
around and use them:

ALT+L marks a line

ALT+U unmarks selection
ALT+D deletes a selected text
ALT+C copies selected text
ALT+M moves selected text
Enter inserts a new line

Highlighting specification fields
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The LPEX editor highlights the Tokens (specification fields) of your RPG program
source, providing a separate color for each, improving readability. When you make
changes to a line, the token colors get updated only after you move your cursor off
the line.

To see how token highlighting works:

1.

2.
3.
4

Move the cursor to a Calculation statement.

Position the cursor to column 7 (right next to the C).
Type an asterisk (*).

Move the cursor off the line and watch what happens.

The line where you typed the asterisk (*) becomes a comment line and its color
changes accordingly.

[ rcemaraeae x N -

Line 26 Colurn 27 Replace 1 change
..... CLOND 1Fac:tor1+++++++CEcode ({E) +Extended-factors +++++++

000100 x
000200 *
000300 ® Semple RPGIV program to access file CUSTOML3
000400 * Used in WDT hands on LAB
000500 * Created by Claus Weiss
o0oos00 x
000700 * F spec for file CUSTONML3 keyed by customer number
0oos00 FCUSTOML3 IF E K DISK
000900 Fr
001000 D*Input parameter from Web page
001100 DCustnoi = like [CUSTNOG)
001200 D* Data structure to specify output structure to reti
001300 I CSTRUC E DS exthname (customl
001400 D feedback = 20
001500 C TENLEY plist
001600 o parm cusSthoi

mﬂﬂ C* parm catruc |
001800 C parm feedback
00z100 C eval feedback=*blank

Move the cursor back to column 7 and remove the asterisk (*).
Move the cursor off that line of code and the statement is tokenized.

The token highlighting changes to reflect that this is a non-commented C
specification.

Displaying types of lines

Using the LPEX editor, it is possible to have only particular types of source lines
displayed at a time.

To display types of lines:

1.
2.

Right-click anywhere in the Editor window.

Click Filter view on the pop-up menu.

The menu items list the types of line selections that can be made.
Click Comments.

The Editor window now contains only those RPG statements that are
comments.
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oo < NG 2

Line 5 Column 8 Insert 3 changes
....... Blasdicaediinntiaed suahaaduecva B uannvanhy
ooo100 L
00o0zo0 *
000300 * Sample RPGIV program to access file CUSTOML3
000400 ® sed in WDT hands on LAB
ooosoo ® Created by Claus Weiss
0ooea0 *
B ooo7oo0 * F spec for file CU3TONL3 keved by customer numbe
aoosoo F*
001000 D*Input parameter from Web page
001zo00 D* Data structure to Specify output Structure to e
00z400 c* Insert code here --——---——--- >
004600 c* Done with inserting code --—-———=—==-— >
i ooa7o00 c=
004200 c*

T

4. Right-click anywhere in the Editor window.
5. Click Show all on the pop-up menu.

Mew »

Prompt F4
Syntax Check Line

CLE CER
Copy. CErl4Insert

Paste CEHHY

Select 3
Selected »

Deselect At

Filter view 3

Source E

View »

- Add to Snippets...

Save
Show Date Area

All statements types are displayed. In addition, the choices in the pop-up menu
can be used to include only control specifications, user subroutines, and
procedures and others. The Filter Selection option under the Selected option in
the Edit menu allows the selection of only those lines containing a particular
selected character string.

Checking the syntax of a file

Syntax checking is available for RPG code, and by default will be active. The
syntax of RPG code is checked automatically when a change is made to a line, and
the cursor is moved off the line.

When errors are found, they are displayed following the statement with the error.

Keeping track of columns in a specification line

The format line is at the top of the Editor window, just above the first statement. A
format line is used to help keep track of the columns in a particular specification
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line. The content of the format line can vary to reflect the particular type of
specification being keyed such as F specs, C specs, D specs and so on.

To display a format line:

1. Click a line or use the arrow keys and click the left mouse button to make a
line active.

The format line gets updated as a line gets focus.

You can move the cursor right or left with the arrow keys to go from character
to character, or with the Tab key to go from field to field. An indicator on the
format line moves with the cursor to show in which column the cursor is
positioned.

| anaaieas x NG

000100
00DzZ00
000300
000400
000500
000600
000700
0oos00
000s00
001000
001100
001200
001300
001400
001500
001600

=

Column 44 Insert 3 changes

DName+++++++++++ETDsFrom+++To/ L+++1

s 3 % %

*

* F spec for file CUSTOHML3

FCUSTOML3I IF E E DISE

F‘t

D*Input paramecer Tfrom Web page

DCustnol -] @!E (CUSTHNO)

D* Data structure to specify output Structure to rety
D C3TRUC E D3

D feedback = 20

C fentry plisc

C parm

Sample RPGIV program to access ftl& CUSTOML3

Used in WDT hands on LAB
Creacted by Claus eiss

keyed by gustomer nunber

Drd3++++-l—H

extname (customl

Custhnol

You can select a format line for any specification you want.

2. Click Source from the Editor menu.

3. Click Select Format Line on the pop-up menu.

The Format Line Selection window opens.

& Format Line '

Select format line: | gHle(y G

| oK I Cancel I

Now you can start and create the RPG program.
4. Click OK.

You have highlighted tokens of your RPG source, shown only comment lines,
shown all lines, displayed a format line and now you are ready to begin

[.7: Editing an RPG source member and creating a *PGM object.”|

Exercise 2.7: Editing an RPG source member and creating a *PGM

object

Before you begin, you must complete [“Exercise 2.5: Opening a source member for|

fedit” on page 14| and if you were unfamiliar with the editing features of the

Remote Systems LPEX Editor then you must completd“Exercise 2.6: Reviewing]|

[Remote System LPEX Editor features” on page 15
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To make it easier for you, most of the RPG source is already prepared for you. You
have already opened the correct source member GETDATA in a previous exercise
using the Remote Systems view.

Read through the source. It contains an F spec to access file CUSTOML3, which
contains the customer data keyed by customer number. The D specs define the
data structure CSTRUC that you pass back to your Web page and the CUSTNOI
variable that gets passed from the Web page to this program. As well the
FEEDBACK variable is defined as a 20 length character field.

The Entry parameter list is defined as:

CUSTNOI field (this is the input parameter).
CSTRUC structure (this is the data structure for the customer output data).
Feedback field to indicate no success for file access.

The code you have to write here, fetches a customer record by chaining to the
file with the CUSTNOI that gets passed into the program.

To edit then create a *PGM object with RPG:

1.

Add the code to get the customer record and check whether the chain was
successful.

c* Insert code here ————————=——- >

c CUSTNOI CHAIN(e) CUSTOML3

c IF not %found (CUSTOML3)

x4 EVAL FEEDEACE='CUS0001' 4+ CUSTNOI
C ELSE

C EVAL FEEDBACE='0'

c ENDIF

Lol Done with inserting code —--—-—-—-——--- >

Your coding is complete, so let’s create the program.

Click the Save _@ icon on the workbench toolbar to save the member.
Click the X in the Editor window title bar to close the member.

Be careful not to click the X on the workbench window title bar.
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= N D= b =
Tearn| ] o= Outline &3 8
£ 8 | | 0 - An outline is not available,

5 Remote Systems

5] E. QRPGLESRC *file.pf-src 4|
oy GETDASOL.rpgle

i Go To 4
Iy GETDSSOL rpi Open With ’
-y SUBFILEPRZ.1| i 5
"Iy WDSCSRY.rpg_ Drowse W

[y WDSCSRYZ.rp I—- Do

& E. QRPGLESRCP. *file

- QSYSPRT *file.pf- (=) CapY

=[5 SALES *file.pf-dta ..1, Move. ..
By ABC*menu.dspf

(@ STRCODE. *usrspc S0Rer o
3 ik. QGPL.*¥ib.prod-usr G
-l WRLABKX. b test-ust B’ Find String...
i ﬁ%ﬁ’ User libraries =~ Verify
- gk iSeries Commands 4 verify (Prompt)...
- ﬁ iSeries Jobs .
= -D IFS Files

Con |||:|||g (Prompt)

13 ] a YOI
& File systems {v [R CRTBIDRPG. ..

py i i > [SICRTRPGMOD...
- bin 5 3
Add To iSeries Project. .. .
?I__l ciemo R e iy Wark Wifith Compile Commands. .,

4. In the Remote Systems view, right-click the GETDATA member in source file
QRPGLESRC and click Compile (Prompt) > CRTBNDRPG on the pop-up
menu.

The Create Bound RPG Program (CRTBNDRPG) dialog opens.
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@ Create Bound RPG Program (CRTBNDRPG) x|
Program: > |GETD.P.T.0. vl Mame

Library: > | WSSLABKY = Name
Source file: > | QRPGLESRC i Mame, QRPGLESRC

Library: > | WSSLABRHK ¥ Mame
Source member: > | GETDATA "| MName
Generation severity level: 10 0-z0
Text 'description’; *SRCMBRTXT ﬂ Character value.,.
Default activation group: *¥YES >

Advanced Parameters
Compiler options: = _:J £ield
FEVENTF RemovelB)
Debugging views: s‘ FALL b RE
Replace program: =Y -
[ Advanced(:) [~ all Parameters() I Keywords(Z)
CRTBNDRPG PGM(WSSLABXRIGETDATA) SRCFILE(WSSLABKXQRPGLESRC) SRCMBR{GETDATA) OPTION(*EVENTF) ;I
DEGYIEW(*ALL) REPLACE(*VES)
OK I Restore defaults Cancel |

5. In the Debugging views list, select *ALL
6. Click OK to start to compile.

After compile, the iSeries Error List view is shown, listing all compile errors.
You may see only information and warning messages which means your
compile was completed and the program object was created.

Remate System Datalls]Tasks B’ Series Commands Log X, WS4 g List| s ]
5400a ]
Job 272659/ STECKHAMMELANIEJOB submitted to job queue QBATCH in library QGPL. ;I

CRTBNDRPG PGM{WSSLABKA/GETDATA) SRCFILE(WSSLAEXY/QRPGLESRC) SRCMER(GETDATA)
OPTION(YEVENTF) DEGYIEW(*ALL) REPLACE(*YES)
Program GETDATA placed in library WSSLABXX. 00 highest severity. Created ol | 03/23/05 at

15:07:22,
Cause ..., .: Program GETDATA was successfully created in library 'WSSLAEXK. The highest
message severity that resulted was 00. The program creation date and time are 03/23/05 and
15:07:22,

b
Command ll‘\lormal _:] | _'_'J Prompt... | :-'{unl

7. Click the iSeries Commands Log tab to check that the compile was successful.
This log shows the Remote System Explorer job messages.
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If you get a message that there are errors in your program, go through the edit
compile fix cycle.

Fixing errors

In the error list view, check the errors:

1. Double-click the error.

This positions the cursor in the Editor window on the statement that is wrong.
Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTBNDRPG command.

Continue this cycle until you get a clean compile.

ook

You have edited an RPG source member and created a program object.

Module recap

You have completed [Chapter 2, “Module 2. Creating an RPG program,” on page 7
You have learned how to:

e Start the product

* Set the default workspace

* Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

e Display a format line

¢ Edit an RPG source member with the Remote Systems LPEX Editor
* Compile a program object

Now that you have created the RPG program, you can continue to
[“Module 4. Creating a Web project,” on page 41

|Skip [Chapter 3, “Module 3. Creating the RPG service program for your Web application|
([loptional),” on page 23|as you don’t need to do this set of exercises.
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Chapter 3. Module 3. Creating the RPG service program for
your Web application (optional)

|Y0u do not need to do this module if you have done |Chapter 2, “Module 2. Creating an|
IRPG program,” on page 7.

This module teaches you how to add the iSeries service program to your Web
application using the Remote System Explorer perspective. Remote System
Explorer provides a PDM like environment but with a GUI interface, and full
integration with all iSeries programmer tools in the product workbench.

In this module, you will:

e Start the product

* Set the default workspace

¢ Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
* Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

¢ Show all lines in the RPG source

* Display a format line

* Edit an RPG source member with the Remote Systems LPEX Editor
¢ Compile a service program object

If you haven’t used the LPEX editor before, you may want to spend some time
trying some LPEX editor features.

Exercises

The exercises in this module must be completed in order:

* |“Exercise 3.1: Starting the product” on page 24|

* |“Exercise 3.2: Opening the Remote System Explorer perspective” on page 25|

» [“Exercise 3.3: Creating a connection to the iSeries server” on page 27|

+ |“Exercise 3.4: Finding an iSeries source member” on page 28|

* [“Exercise 3.5: Open a source member for edit” on page 29|

[“Exercise 3.6: Reviewing Remote System LPEX Editor features” on page 29|

* |“Exercise 3.7: Editing a member and creating a service program module” on|

[page 33|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 3.1: Starting the product

Now go ahead and start the product.

On your desktop taskbar:

'E IEM WebSphere Development Studio Client For iSeries W60 M@  WebSphere Development Studio Client for iSeries

1. Click Start > Programs >IBM Rational > IBM WebSphere Developer for
iSeries Entry V6.0 > IBM WebSphere Developer for iSeries Entry

A dialog for workspace selection will appear asking you for the workspace
location, unless you used the product before and selected not to show this
dialog again.

workspace Launcher x

Select a workspace

1BM Rational Software Development Platform stores your projects in a directory called a workspace.
Select the workspace directory to use for this session.

Workspace: | Ci\Documents and Settings\Administratorl18M\rationalsdps, Blwsslabixx ﬂ Browse, .. |

I Use this as the default and do not ask again

| oK I Cancel I

The workspace contains all the information about your Development Studio

projects. You can accept the default or store the work related to this tutorial, in
a separate workspace.

2. To name the directory of the workspace as shown above, use the directory
name WSSLABxx.

3. Click OK.

After a few moments of loading, the workbench opens, and the initial window
of the product appears on your desktop.
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Rational Software Development Platform
X

You have just started the product, set the default workspace and now you are
ready to begin [“Exercise 3.2: Opening the Remote System Explorer perspective.”|

Exercise 3.2: Opening the Remote System Explorer perspective

Before you begin, you must complete [“Exercise 3.1: Starting the product” on page|

Check if the window title bar says: Remote Systems Explorer. If it does you are all
set. Skip the next steps and go directly to [“Exercise 3.3: Creating a connection to|
[the iSeries server” on page 27|

To open the Remote System Explorer perspective:

1. In the workbench, check whether you have the Remote System Explorer
perspective already open. Look for the icon in the left taskbar of the
workbench.

2. If you see it, click the @ RSE icon.
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File Edit Mavigate Search Project Run  Window Help

r3- [ $-0-a EAVE- e

|[ B outine 52 =0
ﬁtg:u.tllne is not available.

3. Otherwise, click Window > Open Perspective > Remote System Explorer on
the workbench menu.

The Remote System Explorer perspective opens.

@ rRemote System Explorer - IBM Rational Software Development Plal n =II:I|£{
Fil= Edit Mavigate Search Project Run Window Help

4. |35+ Q Q- | % E]“'EﬂRamote Syste...
= i 5= outling £2 . = E‘H

& o) | . - | 0%R) v A{@utllne is not available.

[ iSeries. .
i windows...
A Linux...
-0\ Power Linux..,
“nie LN, .

e AIX..

El Local...
= Ef Local

S
Bremote ... 2 TasksliSerbs...l”l ==
Root Connections & 2] | 3 | -
Kame I Parent profile I Femate
EfLocal Private Local
~
DlProperties 3\ |E 2 . » =0
Property l Value |
Marne Mew Connection
Mumber of chi... 7
Type An expandable prompt fo...
4 | ja|

|| Anexpandable prompt F...ection: New Connection |

You have checked that the Remote System Explorer perspective is open and now
ou are ready to begin [“Exercise 3.3: Creating a connection to the iSeries server”]
_on page 27.
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Exercise 3.3: Creating a connection to the iSeries server

Before you begin, you must complete [“Exercise 3.2: Opening the Remote System|

[Explorer perspective” on page 25|

To create a connection:

1.

Click the plus sign + beside iSeries under New Connection in the Remote

Systems view.

2. Accept the default profile name.

Eren

Name personal profile

Uniquely name user profile | l

Welcome to Remate Systems, Connections can be sharable by the team or private to
you. Enter a profile name to uniquely identify you from your team members. You wil

decide for each new connection whether it is owned by the team profile or your
prafile,

Profile; | msteckh7tp

Finish Cancel

3. Click Next.

X
Remote iSeries System Connection
Define connection information | I
Parent profile: |msted<h?tp j
Connection namef | s400a ‘\
Host name: s400a] _ﬂ

Descriptions |

¥ Werify host name

<pack | mext> [[CFnsh) | cancel |

In this exercise s400a is used as the name for the iSeries server. You will need
to use the name or IP address of your particular iSeries server.

Chapter 3. Module 3. Creating the RPG service program for your Web application (optional)
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4. Type a host name, for example, s400a in the Host name field.

o

The Connection name field will be filled automatically with the same entry.
6. Click Finish.

Your new connection appears in the Remote Systems view and you are ready
to work with objects on this iSeries system.

You have set up a new connection to an iSeries server and now you are ready to
begin [“Exercise 3.4: Finding an iSeries source member.”|

Exercise 3.4: Finding an iSeries source member

Before iou begin, you must complete [“Exercise 3.4: Finding an iSeries source|

member.”

You will see a list of libraries under Library list in the Remote Systems view. Now
you locate the source you want to edit.

To find an iSeries source member:

[#- 47 MNew Connection -
&l Local
' =) 54003

1 iSeries Objects
-2 Work with libraries. ..
& work with objects...

+- 3 work with members. ..
~+, N oy
g Library list
; i, Q5Ys.Mib.prod-sys

B ﬁ Q5Ys2,Mib.prod-sys
u i} QHLPSYS. *ib prod Sys

E -J DEMORE "‘pgm rpale
: [F] GETDASOL.*pgm.rpgle
[#-[#] GETDASOLY. *pgm.rpgl
[#-[¥] GETDATA.*pam.rpgle

<[] GETDSSOLC, *pam.chile
(2] READDTAQ.*pgm.rpale
F] WRTDTAQ. *pgm.rpgle
[+ 4] GETDATASC *srvpgm.
# ;Q GETDSSOL, *srvpam.rp
[#-pa] ORDENTR. *srvpam.rpe
e ] WDSCSRY, *srvpgm, o

A ArTRATACS s!..]-.J A=

1]

Note: If you don’t see WSSLABxx in your library list, then you need to add the
library. You can right-click the Library list and click Add Library List Entry
from the pop-up menu to add WSSLABxx to your library list.

1. Expand your iSeries server. Use the same server that you have used to specify
the reference fields in the data structure.

2. Expand iSeries Objects by clicking the plus sign + beside it.
3. Expand Library List.
4. Expand the library WSSLABxx.
You will see all objects in this library.
5. Expand the source file QRPGLESRC.
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6. Scroll down to the source members in the expanded list.

You have located an RPG source member you want to edit and now you are ready
to begin [“Exercise 3.5: Open a source member for edit.”|

Exercise 3.5: Open a source member for edit

Before you begin, you must complete [“Exercise 3.4: Finding an iSeries source|
[member” on page 28

One shell source member is provided for you to use.

To open a source member for edit:
1. Right-click member GETDATAS.
2. Click Open with > Remote Systems LPEX Editor on the pop-up menu.

|
-] CUSTOMS4, *file If |
#-[F EVFEVENT *file.pf-dta |
-y INVPRINT *file, prtf |
#-[F PRODDTL.*file.pf-dta |
FRODINY. *flle, pf-dta |
|

=

#-[E PRODSHOW, *file, pf-dta
#-[F PRODUCT *file.pf-dta
-] PRODUCTIF, *file.IF
-y QCBLLESRC, *file.pf-sre
&) Ely QDDSSRC, *file.pF-src |
=2y QRPGLESRC *file pf-src '
: @y GETDASOL.rpagle

[y GETDASCOLZ.rpgle |

[y GETDATA.rpgle
GETDATAS. rpol
-y GETDSSOL.rpale

Go To 4

# Remote Systems LPEX Editor 't
545 CODE Editor

Browse With 4

The Editor window opens and you are ready to write your program.

Tip: You can also double-click on a member to open the Remote Systems LPEX
editor.

You have opened an RPG source member for edit and now you are ready to begin
“Exercise 3.7: Editing a member and creating a service program module” on page]

53]

Now before you edit the member, if you have not worked with the Remote Systems
LPEX editor, go to|“Exercise 3.6: Reviewing Remote System LPEX Editor features”}

If you already know the LPEX editor, you are ready to write your service program, go to
[“Exercise 3.7: Editing a member and creating a service program module” on page 33|

Exercise 3.6: Reviewing Remote System LPEX Editor features

Before you begin, you must complete |“Exercise 3.5: Open a source member for|
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Before you start, here are some useful tips on using the LPEX editor. Let’s look at
some of the features of the LPEX editor, so you can later easily find your way
around and use them:

ALT+L marks a line

ALT+U unmarks selection
ALT+D deletes a selected text
ALT+C copies selected text
ALT+M moves selected text
Enter inserts a new line

Highlighting specification fields

The LPEX editor highlights the Tokens (specification fields) of your RPG program
source, providing a separate color for each, improving readability. When you make
changes to a line, the token colors get updated only after you move your cursor off
the line.

To see how token highlighting works:

1.

2.
3.
4

Move the cursor to a Calculation statement.

Position the cursor to column 7 (right next to the C).
Type an asterisk (*).

Move the cursor off the line and watch what happens.

The line where you typed the asterisk (*) becomes a comment line and its color
changes accordingly.

[ /ceroanas recie x N 2
Line 43 Column & Feplace 1 change
..... PHfoe 4t bt bbbt B e e e s KEGUOTAS b bbb bbbt
0oiz00 HNOMAIN ;l
001300 FCustoml3 if e K disk
001400 D¥ 3imple scructure used for oucput parameters
Q01500 DCSTRUC e ds extname ([customl3:c
001600 D*
001700 D* Prototype for procedure getrecord
001800 D* if you don't specify extproc with lowercase name you
001200 D* GETRECORD in uppercase in Interiction Wizard for entr
oozooo D*
a0z 100 Dgetrecord PR extproc ('getrecor
00zz00 D custnoi 7
0o0z300 D myds likeds (cstruc)
0o0z400 D feedback 20
ooz s00 D
a0z 600 D* Start of procedure
002700 Fgetrecord ] EXpOrtc
00z800 P* Procedure interface
0oz900 D pi
003000 I custnoi 7
003100 D custl likeds{cstruc)
oo3zoo0 I feedback 20
003300 D* end of procedure interface
1] [0k
ﬁu o =xal feedback="plani |
003600 G

Move the cursor back to column 7 and remove the asterisk (¥).
Move the cursor off that line of code and the statement is tokenized.

The token highlighting changes to reflect that this is a non-commented C
specification.
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Displaying types of lines

Using the LPEX editor, it is possible to have only particular types of source lines

displayed at a time.

To display types of lines:
1. Right-click anywhere in the Editor window.
2. Click Filter view on the pop-up menu.

The menu items list the types of line selections that can be made.

3. Click Comments.

The Editor window now contains only those RPG statements that are

comments.
" ™
/ *GETDATAS RPGLE X =
Line 37 Column 1 Insert 2 changes
Koo Lk Bavia i @hson P e B b s vt vinb o
000100 =
Qooz0o0 % SJawple RPGIV program with procedure to access file
000300 " This program has to be created as a Service progrs
000400 * CRTRPGHMOD first then CRTSEVFGH
Qoos00 *® Used in WDT hands on LAB
ooos00 * Created by Claus Weiss
aoo700 *
0oos00 ® F spec for file CUSTOML3 keved by customer number
0oos0o0 X
001000 * J
Dulluu LA A R A R R R AR R A AR RS R ERE SRR RS E SRS SR AR A SR SRS S EEEE S S S
a 001400 D* simple structure used for output parameters
001600 D*
001700 D* Prototype for procedure getrecord
Q01800 D* if you don't specify extproc with lowercase nawme you
001200 D* GETRECORD in uppercase in InterlAction Wizard for entn
f| oozooo D#
00z200 D custnoi 7
00zZ300 I myds likeds (zstruc)
002400 I feedback 20
00z 600 D* S3tart of procedure
a0z 800 P* Procedure interface
003000 D custnoi 7
003100 D custl likeds (zstruc)
003200 I feedback 20
003300 D* end of procedure interface
f oo3400 cw
Q03700 C* ——— > add your code after this statement <—————-
[ oossoo cs
004000 c*
E 004100 CF¥ mmmm——— > your code endsz here <
1 | 2l

4. Right-click anywhere in the Editor window.

5. Click Show all on the pop-up menu.
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Mew »

Prompt F4
Syntax Check Line

CLE
opy

Paste GEHEY

Select 3

Selected »

Deselect At

Filter view 3

Source E

igw »
£ Add ko Snippets...

Save

Show Date Area

All statements types are displayed. In addition, the choices in the pop-up menu
can be used to include only control specifications, user subroutines, procedures
and others. The Filter Selection option under the Selected option in the Edit
menu allows the selection of only those lines containing a particular selected
character string.

Checking the syntax of a file

Syntax checking is available for RPG code, and by default will be active. The
syntax of RPG code is checked automatically when a change is made to a line, and
the cursor is moved off the line.

When errors are found, they are displayed following the statement with the error.
Keeping track of columns in a specification line

The format line is at the top of the Editor window, just above the first statement. A
format line is used to help keep track of the columns in a particular specification
line. The content of the format line can vary to reflect the particular type of
specification being keyed such as F specs, C specs, D specs and so on.

To display a format line:

1. Click a line or use the arrow keys and click the left mouse button to make a
line active.

The format line gets updated as a line gets focus.

You can move the cursor right or left with the arrow keys to go from character
to character, or with the Tab key to go from field to field. An indicator on the
format line moves with the cursor to show in which column the cursor is
positioned.
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[ £cerpatas recie x N 8
Line 35 Column 36 Insertc 2 chapges
..... CLONO1Factor1+++++++0pcode (E @ ended-factor2 -+ttt
001200 HMOMAIN :]
001300 FCustoml3 if e E disk
001400 D* simple sctructure used for oftput paramecers
001500 DCSTRUC e ds extname (customld:c
001600 D*
001700 D* Prototype for procedure getfecord
001800 D* if you don't specify extprof with lowercase name you
001900 D¥ GETRECORD in uppercase in Ijcterliccion Wizard for entr
00zo00 D*
002100 Dgetrecord FR extproc (' getrecor
002200 D custnoi 7
002300 D myds likeds (cstruc)
002400 D feedback 20
002500 D I
002600 D* Start of procedure
002700 Pgetrecord b export
002800 P* Procedure interface
00z900 D pi
003000 D custnol 7
003100 D custl likeds (cstruc)
003200 D feedback z0
003300 D* end of procedure interfaced
003400 C#
003500 C eval @ed.bach*blan}t
003600 C
003700 o > add your code after this statement <-———-—-
003800 c
003900 C
004000 Cc*
004100 CF' ——————— > your code ends here L————————————————————o
004200 o return
004300 P e ||
-
4 | o

You can select a format line for any specification you want.
2. Click Source from the Editor menu.
3. Click Select Format Line on the pop-up menu.

The Format Line Selection window opens.

@i Format Line x|

Select format line:

| oK I Cancel I

Now you can start and create the service program.
4. Click OK.

You have highlighted tokens of your RPG source, shown only comment lines,
shown all lines, displayed a format line and now you are ready to begin
[3.7: Editing a member and creating a service program module.”

Exercise 3.7: Editing a member and creating a service program module

Before you begin, you must complete [“Exercise 3.5: Open a source member for|
ledit” on page 29 and if you were unfamiliar with the editing features of the
Remote Systems LPEX Editor then you must complete [“Exercise 3.6: Reviewing]|
[Remote System LPEX Editor features” on page 29
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To make it easier for you most of the RPG source is already prepared for you. You
have already opened the correct source member GETDATAS in a previous exercise
using the Remote Systems view. Read through the source. It contains an F spec to
access file CUSTOML3 which contains the customer data keyed by customer
number. The D specs define the data structure CSTRUC that gets passed back to
your Web page and the CUSTNOI variable that gets passed from the Web page to
this program. Also variable FEEDBACK is defined as 20 characters, to return
message id and customer number in case the customer record was not found.

The prototype for procedure getrecord with the parameters is defined as the:
* CUSTNOI field (this is the input parameter)

* CSTRUC structure (this is the data structure for customer data)

* FEEDBACK field (returns error or success)

Note: The external name is case sensitive. It has to match exactly what you
specified in the Web Interaction wizard.

The procedure interface defines the parameters in the same way as the prototype.
Inside the procedure after the procedure interface you need to add the RPG code.

Adding RPG code

To add the RPG code:

CF ———m=— > add your code after this statement <-—-—————==——=—~-
Ct

LN CUSTNOI CHAIN(E) CUSTOML3

c IF tfound (CUSTOML3)

c EVAL FEEDEACK='0"

C EVAL custt=|:5truc:

c ELSE

LN EVAL FEEDEACK='CUS0001 ' 4+ CUSTNOI
c ENDIF

C?“

C¥ ————— > your code ends here «————r———rmm——mme————————

1. You do a CHAIN to the database and move the database fields to the local
procedure structure. If the database access fails, move the MSGID and
Customer number to the FEEDBACK variable.

Your coding is complete, so let’s create the service program module.
Creating the service program module

To create the service program module:

1. Click the Save _@ icon on the workbench toolbar to save the member.
2. Click X in the Editor window title bar to close the member.

Be careful, don’t click the X on the workbench window title bar.

3. In the Remote Systems view, right-click GETDATAS member in QRPGLESRC
and select Compile (Prompt) > CRTRPGMOD on the pop-up menu.
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~ Open With »
k& X =] A
e | =l = Browse With »
-5 CUSTOMER.*file.pf
i [ Rename...

0] CUSTOMLL *filef  *—
] CUSTOMLS *filef | '=| Copy

] CUSTOMS1 *File.If e Move

2| CUSTOMS2,*file IF
O CUSTOMS3 #file Jf | 9% Delete...
7| CUSTOMS4, *file ) —
EVFEVENT. *file pf-c P Find String. .

-y INVPRINT #file.prtf = verify

#-[5 PRODDTL.*file.pf-d - .
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[ PRODINY.*file.pf-d = oy Grome)

w-[5) PRODLIST *file pf-c___ Compile £

55 PRODSHOW, *file.p ¥ |1l CRTENDRPG. ..
#-[E PRODUCT *file.pf-c  User Actions

] PRODUCTIF *file: If

2 Add To iSeries Project... T

@ QCBLLESRC.*file.pf 5 Jye Work With Compile Commands. .,
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= [Ely QRPGLESRC *file.p  Debua(Service Entry) P
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GETDASCLZ.rpc
GETDATA.rpale Properties
GETDATAS.rpgle
GETDSSOL.rpgle —I } [Remobe System Details | Tasks | iSeries Table View l iSeties Commands

Compare With 4

PEE S

The Create RPG Module (CRTRPGMOD) dialog opens.

@ Create RPG Module (CRTRPGMOD) x|
Module: > | GETDATAS 'l Mame
Library: > | wssLABKY =] Natie
Source file: > | QRPGLESRC i1 Name, QRPGLESRC
Library: = | 'WSSLABRK 52 Mame
Source member: > | GETDATAS =i MName
Generation severity level: 10 0-20
Text 'description’: *SRCMBRTXT 3 Character value..,
Advanced Parameters
Compiler options: > | vl Fidd
*EVENTF
p——
Debugging views: ( _:I
Replace module: = | *YES -
[ Advanced(x) [~ all Parameters(y) [~ Keywords(Z)
CRTRPGMOD MODULE(WSSLABYX/GETDATAS) SRCFILE(WSSLABXY/QRPGLESRC) SRCMBR(GETDATAS) OPTION(*EVENTF) |
DBEGYIEW(*ALL) REPLACE(*VES)
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4. In the Debugging views list, select *ALL
5. Click OK to submit the command.

After the compile the iSeries Error List view is shown, listing all compile errors.
You may only see information and warning messages that means your compile
was completed and the program module was created.

Remote System Detalls | Tasks B’ Series Commands Log X, WS4 g LBt| s Sl

5400a I

message severity that resulted was 10, The module creation date and time are 03/23/05 and ;]
15:10:52,

CRTRPGMOD MODULE(WSSLABXX/GETDATAS) SRCFILE(WSSLABXY/QRPGLESRC)
SRCMBR{GETDATAS) OPTION(*EYENTF) DEGVIEW{*ALL) REPLACE{*YES)
Module GETDATAS placed in library WSSLABXX. 10 highest severity. Created on 03/23/05 at

15:12:24,

Cause . . .. .: Module GETDATAS was successfully created in library ‘WSSLAEXK. The highest
message severity that resulted was 10, The module creation date and time are 03/23/05 and
15:12:24.,

b
?Commarld !I‘\Jormal :I | _1] Prompt.. | :-'{unl

6. Click the iSeries Commands Log tab to check if the compile was successful.
This log shows the Remote System Explorer job messages. If you get a message
that there have been errors found in your program, go through the edit compile
fix cycle.

Fixing errors

In the iSeries Error List view, check the errors:

1. Double-click on the error.

This positions the cursor in the Editor window on the statement that is wrong.
Fix all errors.

Save the source member.

Go back to the Remote Systems view.

Right-click the member to run the CRTRPGMOD command.

Continue this cycle until you get a clean compile.

I S

Creating a service program

To create a service program:

1. In the Remote Systems view find the GETDATAS module in library
WSSLABxx.

Note: If you don’t see the module, right-click library WSSLABxx and click
Refresh on the pop-up menu.

2. Right-click GETDATAS module and click Create > Service Program on the
pop-up menu.
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<
The Create Service Program (CRTSRVPGM) dialog opens.
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eate Service Program (CRTSRYPGM)

For the service program name, leave GETDATAS.

For the library name, leave WSSLABXX.

In the Export list, select *ALL.

Click OK.

Click the iSeries Commands Log tab at the bottom of the workbench.
You should see a message that the Service program was created.

No oo~

38 Development Studio Client: iSeries Web tools



You have edited an RPG source member and created a service program object.

Module recap

You have completed [Chapter 3, “Module 3. Creating the RPG service program for|
[your Web application (optional),” on page 23| You have learned how to:

e Start the product

* Set the default workspace

* Check the Remote System Explorer perspective is open

* Set up a new connection to an iSeries server

* Locate an RPG source file you want to edit

* Open an RPG source member with the Remote Systems LPEX Editor
+ Highlight the tokens of your RPG source

* Show only comment lines in the RPG source

* Show all lines in the RPG source

* Display a format line

 Edit an RPG source member with the Remote Systems LPEX Editor

¢ Compile a service program object

Now that you have created a RPG service program, you can continue to
[“Module 4. Creating a Web project,” on page 41
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Chapter 4. Module 4. Creating a Web project

This module teaches you how to create a Web project and then supply the
information which the iSeries server will use for serving the business information
for this Web application. You will also learn about perspectives, J2EE settings, Web
projects, and the iSeries Web Tools Run-Time Configuration wizard.

In this module, you will:

* Access tools and views for iSeries Web application development

¢ Know the difference between a static Web project and a dynamic Web project

* Set up a dynamic Web project

* Define where the RPG program or service program resides on an iSeries server

Exercises

The exercises in this module must be completed in order.

+ [“Exercise 4.1: Opening the Web perspective’]

+ |“Exercise 4.2: Creating a dynamic Web project” on page 43|

* |“Exercise 4.3: Setting up the iSeries server information” on page 48|

Time required

This module will take approximately 15 minutes to complete.

Exercise 4.1: Opening the Web perspective

In this exercise you will use the Web perspective. This allows you to access tools
and views specifically related to Web application development. However, you are
still in the Remote System Explorer (RSE) perspective which gives you the tools to
do your iSeries programming tasks as you have discovered in the previous
module.

Perspectives

Before you go further, let’s review perspectives. Perspectives are a collection of
views and tools assembled to help different kinds of users to do their job when
they use the workbench. These workbench users will have different jobs (roles), for
example, one user needs to work with iSeries objects related to RPG/COBOL,
another user is dealing with Java programs, and another user with Web page
development. Each of these different user types will need different views of the
files/objects they are working with and they need different tools. The perspectives
present the user with a selection of specific views/tools geared towards the
different roles the users have. The workbench has many predefined perspectives,
like the:

* Web perspective for Web developers.
* Remote System Explorer perspective for iSeries programmers.

You can also create your own perspective by using the Save Perspective as option
under the Window menu in the workbench, after you have modified a perspective.
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Now that you know what a perspective is you can go ahead with our exercise. You
are a Web developer in this tutorial and that is the reason you will select the Web
perspective. The Web environment provides its own perspective since it needs to
give its users access to unique views and tools targeted towards Web tasks. You
create a Web project in the Web perspective.

To open the Web perspective:

N [=]
J - J H-0-9- ‘ | 79 | EBremote Syste..,
BRemote Systems $3 . Team . TRiSeries Projects
& e | | = . ERemobe System Explorer
& e |-
. Customize Perspective. .. i
] .Q CORDEMTR. *srvpam.rpc Save Perspective 8. .. EﬁWahFacng
- &) GETDATAS *module SRR
&1 §) GETDATASC. *module Clasa Perspeciie
#- ] GETDSSOL. *module Close 4l P e
-5 SLTPARTRFA. *module i fit o)
& [ CELDIAL *msaf Navigation »
[ INVMSGF, *msgf
- [ MYMSEF. *msaf Preferences

1. Click Window > Open Perspective on the workbench menu.
2. Then click Other on the pop-up menu.
The Select Perspective dialog opens.

@ Select Perspective _35]

‘3& Debug

B iseries Projects

(@ J2EE

aj Java

:E\J Java Browsing

T‘gJ Java Type Hierarchy

:E Remake System Explorer (default)

. 2

I Show al

3. Select Web from the list.

4. Click OK.
The workbench will now show the Web perspective with the Project Explorer
view open on the left hand side.
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@& web - IBM Rational Software Development Platform -10] x|
Fil= Edit Mavigate Search Project Run Window Help
Y o e | EE | @web
- THRremate Syste. .,
o T =
= 2\ =0
o A palette is nok
= available.
1 Application Client Projects

L4 Connectar Projects

&-§ EJB Projects

[+ Dynamic Web Projects

- [ Other Projects

[ Web Services

- Databases h_

L[ Database Servers

- i N » = Elp rti S@N\ = = E\

o= Outline &3 . Page Data] 3 O roperties \

#An outline is not available, S -

Property | Value
dl |
| 27 | \/& Enterprise Applications |

You have accessed tools and views for iSeries Web application development and
now you are ready to begin [“Exercise 4.2: Creating a dynamic Web project.”]

Exercise 4.2: Creating a dynamic Web project

Before you begin, you must complete [“Exercise 4.1: Opening the Web perspective”]
Web projects hold all of the Web resources that are created and used when
developing your Web application. The first step to creating or importing a Web
application is to create either a static or a dynamic Web project. Static Web projects
are meant to contain only simple Web site resources, such as HTML files. Dynamic
Web projects are used to structure Web applications that will use more
complicated, dynamic Web technologies, such as JavaServer Page files, and
possibly data access resources.

To create a dynamic Web project:
1. Click File > New on the workbench menu.
2. Then click Dynamic Web Project on the pop-up menu.
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@ web - IBM Rational Software Development Platform 5 -0 x|
| Fle Edit Mavigate Search Project Run  Window Help
Alt+Shift+N
Close Cerl+F4
Close & CEr-Shift+F4
[ Cirl4s
B sevefs, 557 HTMLIXHTML File
IS 5ave Al Cil+ShiftH5 [ 35P File
LCYEL |$] Faces J5P File
MEVE © Page Template File

This starts the Dynamic Web Project wizard. The initial page of the wizard
opens.

& New Dynamic Web Project o x|

Dynamic Web Project

Create a standalone Dyn%ic Web project or add it ko a new or existing Enterprise Application project. | o

Name: ‘l wsslabxxi )

Project lacation: |C:'I,Documsnts and Settings!\Administrator\IBM\rationalsdp6.0lw  Browse... |

Show Advanced =

< Back I Mext > ]l Einish I Cancel

3. Accept the default value in the Project location field.

This is where your project is stored in your file system.

In the Project name field, type WSSLABxx.

Click Show Advanced to specify the servlet version of your Web project.
Leave the Servlet version as 2.4.

N o o s

Leave the Target server as WebSphere Application Server v6.0.
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@ New Dynamic Web Project ; x|

Dynamic Web Project

Create a standalone Dynamic Web project or add it to a new or existing Enterprise Application project, | o

hame: ] wsslabiex

Praject location: IC:'I,Program Files\IBM|R ational\SDPY6.0ywsslabxxmar 23 wsslabx Erowss...l

I Hide Advanced <<

Servlet version: |2.4 ﬂ

AT RYTE | ebSphere Application Server vi.0

¥ add module to an EAR project.

EAR project: stslal:oO(En.R j Ne,w...l

Context Root: | wisslaboce

[ Add support for annotated Java classes

ceac | Next> H Frish | Cancel

Click New next to the EAR project field.
Click Show Advanced to specify the J2EE version of your Web project.

These options allows you to specify the J2EE version for the Web project. If
you plan to use the WebSphere Application Server Version 6 only, then you

select J2EE version 1.4. If you are using previous versions of WebSphere

Application Server in your environment and are planning to deploy the Web
application to these versions then you use J2EE version 1.3 or 1.2 since these

earlier versions of WebSphere Application Server don’t support the J2EE

version 1.4. In this exercise you use the Web application in the WebSphere

Application Server (also known as the WebSphere Test Environment), which is

Version 6.0, so you use J2EE version 1.4 which is the default.

(I x|

Enterprise Application Project

Create an Enterprise Application project containing one or more module projects,

Name: | wsslabxxEAR

Project location: |C:1.Program Files\IBM\R ational\ SDPY6. Dhwsslabxxmar2 3 wsslabx Browse.'.l

I Hide Advanced <<

J2EE version: [1.4 =
Target server: |Web5phere Application Server v6.0 :] Mews.,. |
Finish Cancel
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10.

11.

12.
13.

14.

15.

16.

17.

18.

Leave the default value for the Name field.

A new or existing Enterprise Application project must be associated with your
new Web project for purposes of deployment.

The Enterprise Application project is new, so you typed the name of the new
project. When your Web project is created at the end of the wizard, the new
Enterprise Application project (EAR file) is also created. The default is an
Enterprise Application project named DefaultEAR located in the same
directory as your new Web project.

Leave the default value in the J2EE version list.
By default, the Web project’s J2EE level is set to the Workbench’s J2EE version.

Any new servlets and JSP files that you create should adhere to the latest
specification level available; previous specification levels are offered to
accommodate any legacy dynamic elements that you expect to import into the
project.

Click Finish on the Enterprise Application Project page.
Click Next.

The Features page opens.

& New Dynamic Web Project x|

Features
Select a Web Project feature. A feature can provide additional functionality For the Web Project. | 0
Web Project features: Description:

| Default style sheet (CS5 file) | | select this feature to have a C55 file generated for - |
-l Default synchronization polscy for CYS reposil your praject
! Beries Web Components Tag Library
j truts
L WDO Relational database runtime
~-[] Web Diagram

[J O 5P Tag uhranes =
=0 amm o~ - (]
< | L

<gack [Crext) [ Fiish |  cancel |

Leave the Default style sheet (CSS) check box selected to create a default CSS
file (called Master.css) for any HTML and JSP files included in the project.

Select the iSeries Web Components Tag Library check box as you want to
add iSeries fields and controls to the Web pages of your Web application.

Select the Struts check box as you want to create a project that uses Struts
technology.

Leave the Web Diagram check box selected to create a Web diagram in the
project.
Click Next to go to the Select a Page Template for the Web Site page.
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& New Dynamic Web Project

Select a Page Template for the Web Site

Select a default page template for the Web site, This page template will be applied to new pages
created using Web Site Designer, < >

@Usa a default Page Template for the ‘AI:@ site
Page template type
(* sample page template " User-defined page template

Page Template File

Location; l Browse... «

D- il

A_blue.htpl A_gray htpl A_areen.htpl _"_.I

File name: | A_blue.htpl

Thurmbnail;

< Back Finish Cancel
(> )| I

19. Select the Use a default Page Template for the Web site check box.
20. Click the A_blue.htpl thumbnail.
21. Click Next.

22. On the Struts Settings page, ensure that Create a Resource Bundle is selected.
If not, select the Override default settings check box and then select Create a
Resource Bundle for the Struts project.

& New Dynamic Web Project . x|

Struts Settings
Select the initial settings for Struts | o

Override default settings

=oethings
Struts Version; | i > I

Default Java package prefix: I-:om,ibrn.wsslabxx

W | Creste a Resource Eundle

23. Click Finish to create the Web project.

Now you are back in the workbench and your new project and project files
appear in the Project Explorer.
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(A Enterprise Applications
Lz Application Client Projects
L_# Connector Projects

L@ EJB Projects

L Dynamic Web Projects

o) -

() Other Projects
[ Web Services

[ Databases

L Database Servers

You know the difference between a static Web project and a dynamic Web project
and have set up a dynamic Web project and now you are ready to begin

[4.3: Setting up the iSeries server information.”|

Exercise 4.3: Setting up the iSeries server information

Before you begin, you must complete [“Exercise 4.2: Creating a dynamic Web|
[project” on page 43

Before you can start creating your application, you will need to define where the
RPG program you will connect to later on in this tutorial is located. You need to
specify the iSeries server name and the user-ID and password to be used when
starting the job on the iSeries to run your program.

To set up the iSeries server:
1. In the Web perspective, right-click the WSSLABxx project in the Project
Explorer.
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[#-l/g Enterprise Applications
] I__J Application Client Projects
# Lg Connector Projects
#-L@ EJB Projects

=2-Lg Dy \Web Projects

[+ Other Proj
L5 Web Servi -
i i=1C

L g Databases l;.. Ry
& (f Databass - Paste

3 Delete

Refactor Alt+Shift+T »

Impart... »
Export... 4

= Refresh
Close Project

BF outline 82
An outline is not a%

2. Click Specify iSeries Web Tools Run-Time Configuration on the pop-up
menu.

Tip: You could also use the ﬂ button from the workbench toolbar to open
the Run-Time Configuration wizard.

The iSeries Web Tools Run-Time Configuration wizard opens.
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@& iseries Web Tools Run-time Configuration x|

Configure Authentication
Specify how program call Web interactions should connect and authenticate H

" prompt for user 1D and password
% sign on with specified values

Host name: | 54003

UserID: | WLABxx

ek

Password: |
¥ Enable password encoding

Cancel I

You use this wizard to specify how Web interactions that perform program
calls to an iSeries host should be connected and authenticated.

3. In the Host name field, type the name of the iSeries host where your program
is located, for example s400a.

4. Enter your user ID and password for the iSeries host in the appropriate fields.

You need to ensure that your User ID has been set up in a way that it
contains the correct library list. If not, you will have to use the table on the
next page to add a library to the library list when the job gets started to run
your program.

5. Enable password-encoding is selected by default. This option ensures that the
password appears in encoded format in the web.xml file. If you clear the

check box for this option, the password appears as plain text in the web.xml
file.

6. Click Next.

7. (Optional) If you need to add WSSLABxx to your library list, then type
WSSLABxx in the Library field and click Add.

8. Select the Display detailed run-time errors check box to see the details for
any errors that occur during the runtime of your Web application. This is
useful for tracing and debugging development errors that may occur.
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@i iseries Web Tools Run-time Configuration L

Configure Run Time

€3 Message file name is invalid

~Run-time library list

-

Library: | b
Library I Library Position | Remove I
Move Up |
Mave Down I
Current library: ]*LISRPR.F j
Initial command:
@]splay detailed run-time errors
~ Session timeout procedure
Library: I Program object: I
Entry point: | Program byps: | *SRYPGM =]
—Message handling
Message resource: ] comiibmiwsslabioiresources\applicationResources, properties

< Back I Mext = I

Finist Cancel I

9. Select the Use iSeries message file check box to retrieve error messages from

the iSeries host.

10. Click Browse to specify the iSeries message file.
11. Click the plus sign + beside s400a.
12. Click the plus sign + beside *LIBL.
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& Message Resource Selection ] x|

Select a message file object,

1@@ s400a

& }:‘u Whork with libraries. ..

@}—:o *+LIBL

OK Cancel

13. Drill down to WSSLABXX > MYMSGF.*msgf.

& Message Resource Selection ] x|

Select a message file object, %

| mvmscr

& se00as -l
=B s400a

e 3%‘2 ‘Waork with libraries. ..
o +LIBL
B iy QSvS2924.¥ib.prod-sys
Bl QsYS.*ib.prod-svs
-, QsYS2.*ib.prod-sys
- i, QHLPSYS. *iib.prod-sys
-, QUSRSYS b prod-sys
- ik QGPL.Hiib.prod-usr
B i, WRLABN b, test-usr
@m WSSLABNK, *lib.prod-usr

(& CELDIAL.*mscof

£

][+

14. Click OK.

15. Click Finish to define authentication and run-time values for your host

program or procedure call to be made by your Web interaction in the Web
project.
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You have defined where the RPG program or service program resides on the
iSeries server.

Module recap

You have completed [Chapter 4, “Module 4. Creating a Web project,” on page 41
You have learned how to:

* Access tools and views for iSeries Web application development
* Know the difference between a static Web project and a dynamic Web project
* Set up a dynamic Web project

* Define where the RPG program or service program resides on an iSeries server

Now that you have created a Web project, you can continue to [Chapter 5, “Module|
[5. Creating a Web application,” on page 55
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Chapter 5. Module 5. Creating a Web application

This module teaches you how to create the interaction to use an input and output
page, and to create the servlet to invoke an RPG program to get data from the
iSeries database. You will also learn about interactions, Web input and output
pages and Program Call Markup Language (PCML). Finally you will learn how to
see the flow structure of your Web application.

In this module, you will:

e Start the Web Interaction wizard

¢ Create an input page that invokes the interaction

* Create an output page that displays the results of the interaction
* Get the program interface definitions

* Specify the input and output parameters

* Specify the input parameters to show on the input page

* Specify what data to show on the output page

* Specify what will happen when an incorrect customer number is entered
* Change the background color of the output page

* Make sure the customer number field is read only

¢ Know what Struts is all about

* View the flow structure of your Struts-based Web application

Exercises

The exercises in this module must be completed in order.

* [“Exercise 5.1: Invoking the Web Interaction wizard” on page 56|

» [“Exercise 5.2: Specifying the input and output page” on page 58|

* |“Exercise 5.3: Defining the iSeries GETDATA program invocation and|
parameters” on page 60|

* |“Exercise 5.4: Defining the iSeries GETDATAS service program invocation and]
parameters” on page 66|

“Exercise 5.5: Defining the input page content” on page 73|

“Exercise 5.7: Specifying error handling” on page 77|

I

. |”Exercise 5.6: Defining the output page content” on page 75|
I
I

“Exercise 5.8: Enhancing the output page” on page 79

* |“Exercise 5.9: Ensuring the customer number field cannot be modified” on page]

52

* |“Exercise 5.10: Visualizing the flow structure of your Web application” on page

5]

Time required

This module will take approximately 30 minutes to complete.
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Exercise 5.1: Invoking the Web Interaction wizard

During this exercise you will use the Web Interaction wizard to create the interface
description for parameters to be passed to an iSeries program. You will also
generate a Web page based on the parameters definition used by the program.
Some of the parameters will be defined based on existing iSeries database field
definitions.

To invoke the Web Interaction wizard:

=7 N », =4 F
= !g o |
5w A palette is not |
: : available,
#-Irg Enterprise Applications
i+ L) Application Clisnk Projects
[ f# Connector Projects
#-Lg EJB Projects
=L Dynamic Web Projects
| B2
[ () Cthe [ Project...
@ L web —————————
a-CQ Date H=/ CoPY (37 Java Project
L Datz % Paste ¥ Packags
3 Delete G Class
Refactor Alt+shift+T » ¥ Interface
Tpoct... » #1 Source Folder
Expait Y L7 HTMLIXHTML File
. Refresh |&] ISP File
Close Project |+] Faces J5P File
‘D= outine £ Run Yalidation <’ Page Template File
Anoutline is " Specify iSeries Web Tools Run-time Configuration ..., L4 Javascript File
Run » & CS5File
tery P [& Image File
Prafile »
Deplay
Team
Compare With Crrl+M

1. Right-click WSSLABxx in the Project Explorer.
2. Click New > Other on the pop-up menu.
3. Expand Web in the list.
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@rew x|

Select a wizard

iSeries Web Interaction Wizard

\Wizards:

C55 File
" Dynamic Web Project
|@] Faces ISP File

2@ Filker

Sk HTMLIXHTML File
& Image File

o JavaScript File
3] 5P File

%y Life-cycle Listener

i '<>‘|’ Page Template File
5 Servlet

51 Static Web Project

=

< Back I Mext > I Firilsh Cancel

Select Web Interaction from the list.

Click Next.

An interaction is the span between the submit of a request from the current

Web page to the post of a new Web page. An interaction could be a simple
request to the HTTP server to load another page. In this environment an

interaction will be made up of a call to an iSeries program, waiting for the
return of the program with data and then invoking a JSP to show the next Web
page containing the data returned from the program.

First you have to give the interaction a name so you can reference it later on.

The Specify a Name and Location for your Web Interaction page opens.
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@ web Interaction - New x|

Specify a Name and Location for yu%lleh Interacktion

Specify the name and location for the resources created For this Web Interaction. %’

Destination Folder: | fwsslabio:webContent Browse, .. |

‘Web Interaction name: ‘ustlnquirv ,

Java package prefix: Icom.ibm.wsslabxx

[V Use error page |.l‘errur.jsp Browse... |

[ Invalidate session after the interaction occurs

™ Terminate iSeries connection

< Back (@] Firish | Cancel

6. Type custInquiry in the Web Interaction name field.
7. Click Next in the Web Interaction wizard.
The Specify the Input and Output Pages for your Web Interaction page opens.

You have started the Web Interaction wizard and now you are ready to begin
[“Exercise 5.2: Specifying the input and output page.”|

Exercise 5.2: Specifying the input and output page

Before you begin, you must complete [“Exercise 5.1: Invoking the Web Interaction|
[wizard” on page 56

The next page of the Interaction wizard asks for information about the Web pages
that are involved in this interaction. You have an input page that invokes the
interaction and an output page that displays the results of the interaction. The
output page shows in the browser at the end of the interaction. The wizard
generates both Web pages for you.
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@ web Interaction - custInquiry

Specify the Input and Output Pages for your Web Interaction

You can use previously designed input and output pages for this \Web interaction or you can have the wizard generate them. %

enerate input page I
Use input pages:

@Eeﬁerabe output pages
" Use output pages:
JeustinquiryResults. jsp

[ Generate inputfoutput pages using a page template

1. Click the Generate input page radio button.
2. Click the Generate output page radio button.
3. Select custInquiryInput.jsp and click Rename.

x|
Specify g name for the input J5P file

‘ !inquirv.jspl ’

Cancel I

Enter inquiry.jsp as the new input JSP file name.
Click OK.
Select custInquiryResults.jsp and click Rename.

Enter result.jsp as the new output JSP file name.
Click OK.
Click Next.

The Specify the Input and Output Parameters for your iSeries Host Program
page opens.

© o N Ok

You have created an input page that invokes the interaction and an output

page that displays the results of the interaction and now you are ready to begin

“Exercise 5.3: Defining the iSeries GETDATA program invocation and|
parameters” on page 60.]
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[To define the iSeries GETDATA program invocation and parameters go to [“Exercise 5.3]
[Defining the iSeries GETDATA program invocation and parameters.”|

To define the iSeries GETDATAS service program invocation and parameters go to
[“Exercise 5.4: Defining the iSeries GETDATAS service program invocation and|
|parameters” on page 66.)

Exercise 5.3: Defining the iSeries GETDATA program invocation and
parameters

Before you begin, you must complete [“Exercise 5.2: Specifying the input and|
[output page” on page 58|

The next page asks you to define the parameters you want to pass between the
Web pages and the iSeries program that processes the requests.

Here you will re-use the PCML program interface definition that was created when
you compiled your source member.

@ web Interaction - custInquiry x|

Specify the Input and Dutput Parameters for your iSeries Host Program

Specify details about the program ko invoke. Click Add Parameter to define a program parameter. %

" Use an iSeries program or procedure " Use a Javabean € ‘Noprogramical

Program call definitions Add Program...

£y

acdperaeter, | add Structure...

Add Program
Program alias: | |

i

Program object; |

Library: | _'_l
Frogram type; [*PaM =]

Browse I
Entry point: | wasal

=

=l

CCSID of entry point: |

Return type: [veid =
Parse order:

Thread safe; [False =l
Source location: | = e

¥ Bszociste this program with the interaction

Synchronize Al | oo |

Getting the program interface definitions

To get the program interface definitions that you want to call on the iSeries:
1. Click Import PCML
The Import PCML dialog opens.
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x

—PCML File
You can import a standalone PCML file or directly from ILE COBOL ot ILE RPG source code,
Select PCML file fram: | B

PCML file:

Select programs of structures to import Tree view of PCML file

Select Al Deselect Al

| OK I Cancel

2. Click the arrow on the Select PCML file from field
3. Select Remote/Local File System from the list.

The Browse For File dialog opens.

@i Browse For File x|

Select afile

H

-h-

s400a
:7‘2 *LIBL
& ih, Q5vs.Mib.prod-sys
- Qsvs2.¥ib.prod-sys %
-l QHLPSYS. *ib.prod-sys
-, QUSRSYS.*lib.prod-sys
G- ify RSELABXX.*ib.prod-us
-, QEPL.Hlib. prod-usr
-l WFLABRS, ¥iib, test-usr
=iy WsLABKK Mib.prod-usr
Y
5 JQDLS
&2, JQFileSyr.400
2 JQNetWare
#Fs JQNTC =
“gha /QOpenSys
o5n JQOPT i

L lnacwe 1 Te

|»

4. Expand the tree view of *LIBL and then look for the library WSSLABxx where
the RPG source is stored. You will use the source file to generate the PCML.
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It should be in WSSLABXX/QRPGLESRC/GETDATA

@i Browse For File x|

Select afile

| WSSLABXR{QRPGLESRC(GETDATA)

& INVPRINT  *file. pref Al
- E PRODDTL. *file.pf-dta
15 PrODINY. *file.pf-dta
PRODLIST. *file.pf-dta
PRODSHOW . *file pf-dta
PRODUCT *file pf-dta
)] PRODUCTIF. *file.If
(=l QCBLLESRC Hfile.pf-src
[Ey QDDSSRC *file. pf-sre [}g
QRPGLESRC, *file.pf-src
Iy GETDASOL.rpale
g TN
t!ﬁ!GETD.iTn.rpu;'E »

A £} e N
[0y GETDSSOL.rpgle
..y SUBFILEPR2.rpgle
By WDSCSRV.rpgle
By WDSCSRYZ.rpgle i

1 [F anne conen #8la nf -

5. Select the correct file.
6. Click OK.

7. The Import PCML dialog appears with a list of the program interface
constructs. You will import PCML directly from ILE RPG source code
GETDATA.
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x

—PCML File
You can import a standalone PCML file or directly from ILE COBOL ot ILE RPG source code,
Select PCML File From: IRemote,l'Lacal File System ;I

PCML file: C:\Program Files\I8M\RationallSDP6. Olwsslabuxmar2 3y metadatal,.p

Select programs ot structures to import Tree view of PCML file

M %, csTRUC -4 CUSTNOI ]
A= ceTDaTa = ¢# CSTRUC (CSTRUC)
L g9 cusThD
&9 CUsTHA
59 REPNO
69 CONTAC
69 CPHONE
59 CFAX
-4 CADDR
&9 CCOUNT
o9 czp
PL
BE ??l:rfnanrl? ;’

[ Cocectal F | vessectan |

. | conce |

* A data structure

* A call interface
8. Click Select All.
9. Click OK.

Specifying the input and output parameters

The Specify the Input and Output Parameters for your iSeries Host Program page
opens again, now containing the program description you just imported.
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@ web Interaction - custInquiry i x|

Specify the Input and Output Parameters for your iSeries Host Program
Use this page to define the input and output parameters for your iSeries host program., %
% Usa an (Serles program or procedure ™ Use a Java bean € No program cal
Program call definitions Add Program. .. | Add Parameter.. I Add Structure, .. I
Y =]
B o, CSTRUC _v | | Edit Parameter
SETSL
Parameter name: I CUSTNOT
=43 UL (CSTRUC) . I—ﬂ
o FEEDBACK Data bype: character
Structure name: I = I
Length: l 7 "l
Precision l ¥ | i%
Count
Usage: >
Initial value
[~ Advanced, ..
Specify database reference field Specify., Synchtonize ]
Show database field definition Show.i.

Tmport PCML... | Synchronies Al | I@ conce |

< Back | fiext > | Einieh | Cancel

1. Expand GETDATA in the left pane under Program call definitions.
The PCML information from the source file gets included in the right pane
and the parameters defined for this program appear.

2. Select the first parameter CUSTNOL

3. In the right pane, change the Usage field from input & output to input to
indicate that this parameter is used to pass a value from the Web page to the
program.

4. Click OK
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& web Interaction - custInquiry ‘_ Ll
Specify the Input and Output Parameters for your iSeries Host Program
Use this page to define the input and oukput parameters For your iSeries host program, %
(¥ Use an [Series program or procedure " Use a Javabean € Mo program call
Frogram call dfinitions Add Progran.... | Add Paraer | Add striiirre,. |
Y =l
£ o, CSTRUC | | EditParameter
- GETDATA
it Parameter name: ICSTRLIC
’ Data type: |structu'a "
Structure name: CSTRUC s
Length: | 'I
Precision: I 'I %
Counk: |
Usage: =
Initial value:
I advanced...
Spedfy database reference field Specify.., SyTichionize |
Show database field defintion SHaW
. r
Import POML... |  Syncheonze Al | o) conc |
< Back. Next = Finish Cancel

In the left pane select the CSTRUC parameter.

In the right pane, change the Usage field from input & output to output,
indicating that this parameter is used to pass a value from the program to the
result Web page.

Click OK.
Do the same for the FEEDBACK parameter.
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|
Specify the Input and Output Parameters for your iSeries Host Program
Use this page to define the input and output parameters for your Series hosk program, %
1% Use an iSeries program or procedure " Use a Javabean € e program caf
Program call defintions add Program, .. I add Parameter, ., ] Add Structure. ..
=/ =
P, _~| | EditProgram %
e Program alias; | GETDATA
< @] CSTRUC (CSTRUC) Program object: | GETDATA Eromse. .
FEEDBACK

al Lbrary: | "L =
Program bype: I'PGM ﬂ
Entry point; | ceTRATA Browse. .
CCSID of entry paint: |
Return typs: [void |
Parse order: CSTRUC ;l

FEEDEACK
Jod|
Thread safe: [fals2 =l
Source location: | =] ._l
@Asmdace this program with the interaction
Inpart PCML... | Synchronze Al | @ el |
<tk | 0 | e | cancel

9. Now select GETDATA in the left pane under Program call definitions.
This will fill the right pane with program information.

10. In the right pane, select the check box Associate this program with the
interaction.

11. Click OK.
12. Click Next.

You have defined the program interface definitions and now you are ready to
begin [“Exercise 5.5: Defining the input page content” on page 73]

Skii the next exercise and continue with [“Exercise 5.5: Defining the input page content”

Exercise 5.4: Defining the iSeries GETDATAS service program
invocation and parameters

Before you begin, you must complete [“Exercise 5.2: Specifying the input and|
[output page” on page 58|

The next page asks you to define the parameters you want to pass between the
Web pages and the iSeries service program that processes the requests.

Here you will re-use the PCML program interface definition that was created when
you compiled your source member.
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& web Interaction - custInquiry

Specify the Input and Output Parameters for your iSeries Host Program
Specify details about the program to invoke. Click Add Parameter to define a program parameter.

Getting the program interface definitions

To get the program interface definitions that you want to call on the iSeries:
1. Click Import PCML.
The Import PCML dialog opens.
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x

—PCML File
You can import a standalone PCML file or directly from ILE COBOL ot ILE RPG source code,

Select PCML file fram: |
PCML file: ——.

Select programs of structures to import Tree view of PCML file

Select Al Deselect Al

| OK I Cancel

2. Click the arrow on the Select PCML file from field.
3. Select Remote File System from the list.
The Browse For File dialog opens.

@i Browse For File x|

Select afile

|
A

B s400a
o HUIBL
-, Q5YS Hlib.prod-sys
' ﬂ% QSYS2,*ib.prod-sys %
-l QHLPSYS.¥ib.prad-sys
-, QUSRSYS,Mib.prod-sys
- iy, RSELABXX.*ib.prod-usr
-l QGPL.Mib, prod-usr
G- [, WFLABNX, b test-usr
=iy WsLABKK Mib.prod-usr
gk |
i lQDLS
ﬁ IQFilesyr.400
& [QNstiware
£ JQNTC L
gks 1QOPENSYS
gka JQOPT r

L lnacwe 1 Te
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4. Expand the tree view of *LIBL and then look for the library WSSLABxx where
the RPG service program source is stored. You will use the source file to
generate the PCML.

It should be in WSSLABxx/QRPGLESRC/GETDATAS.

@i Browse For File x|

Select afile

l WSSLABKKIORPGLESRC(GETDATAS)

& INVPRINT  *file. pref A
- E PRODDTL. *file.pf-dta

13 PrODINY. *file.pf-dta

- [F PRODLIST. *file.pf-dta

PRODSHOW . *file pf-dta

PRODUCT *file.pf-dta

)] PRODUCTIF. *file.If

(=l QCBLLESRC. Hile.pf-src

[E QDDSSRC. *ile pf-src

[-3=) QRPGLESRC.*file.pf-src

! My GETDASOL.rpgle

- -y GETDASOLZ.rpgle

@ SUBFILEPR2.rpgle
By WDSCSRY.rpgle
. -y WDSCSRY2.rpgle
1 Fh anne conen #6la nf s ..:.I

5. Select the correct file.
6. Click OK.

7. The Import PCML dialog appears with a list of the program interface constructs
contained in the PCML file.
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x

~PCML File
You can import a standalone PCML file ar directly from ILE COBOL ot ILE RPG source code,

Select PCML File from: |Remote/Local File System =]
PCML file: C:\Program Files\18M\RationallSDP6. Olwsslabuocapr 2} metadatal,. plu

Select programs ot structures to import Tree view of PCML file

M +%csruc T 4P CUSTNOL |
= GETRECORD = ¢# CUSTL (CSTRUC)
L f® cusThD
69 cusTNA
59 REPNO
6 CONTAC
69 CPHONE
58 CFAY
¢ cappr
o9 cary
&9 CCOUNT
&9 czp
e N
fE ) ?z’:rfnnrl? L’

."@1 Deselect Al

!:a I Cancel I

* A data structure

* A call interface
8. Click Select All.
9. Click OK.

Specifying the input and output parameters

The Specify the Input and Output Parameters for your iSeries Host Program page
opens again, now containing the program description you just imported.
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Spercify the Input and Output Parameters for your iSeries Host Program
LUse this page to define the input and output parameters for vour iSeries host program. ‘

Add Parameter. . | A

1. Expand GETRECORD in the left pane under Program call definitions.

The information from the PCML file gets included in the right pane and the
parameters defined for this program appear.

2. Select the first parameter CUSTNOL

3. In the right pane, change the Usage field from input & output to input to
indicate that this parameter is used to pass a value from the Web page to the
program.

4. Click OK
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& web Interaction - custInquiry ] x|

Specify the Input and Output Parameters for your iSeries Host Program
Use this page to define the input and output parameters for your Series hosk program, %

1% LUse an iSeries program or procedure " Use & Javabean = he program cal
Program call defirtions Add Program... I Add Parameter,,, | Add Structure. |
] = > :
o4, csTRUC = | | Edit Parameter
(=] GETRECORD
i WT=oTe Parameter nams: CUSTL
Data bype: struckure .
Struckure name: |CSTRUC ¥ I
Length: | Y |
Precision: | ¥ I
Count: I
Usage: x
Tnitial value:
™ advanced...
Specify database reference field Sy, SYTICHronze |
Show database field definition show..
Inpart PCML... | Synchronze Al | @ ol |

< Back Next > Finish ] Cancel

5. In the left pane select the CUST1 parameter.

6. In the right pane, change the Usage field from input & output to output,
indicating that this parameter is used to pass a value from the program to the
result Web page.

7. Click OK.

8. Do the same for the FEEDBACK parameter.
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{8 Web Interaction - custinguiry B x|

Specify the Input and Output Parameters for your iSeries Host Program

Use this page to define the input and output parameters for your Series host program, %

1% Use an iSeries program or procedure " Use a Javabean £ No programical

Program call defindtions AddProgram... | add parameter... | Add structure...
il =]

@ o, CSTRUC

-] GETRECORD

;l Edit Program
Program akas: | GETRECORD
Program object: | GETRECORD Browiss. ..
Library: | "B |
Program bype: I'PGM ﬂ
Entry point: [ getrecard J
CCSID of entry paint: |

Resturn typs: [void |

Parse order: :.F

Thread safe: [fals2 =l

Source location: | = veni |

[~ Associate this program with the interaction

Inpart PCML,.. | Synchronze Al | ok | concel |

Browse... |

9. Now select GETRECORD in the left pane under Program call definitions.
This will fill the right pane with the program information.
10. Change the name of the service program to GETDATAS.
11. Select the Program type *SRVPGM.

12. In the right pane, select the check box Associate this program with the
interaction.

13. Click OK.
14. Click Next.

You have defined the program interface definitions and now you are ready to
begin [“Exercise 5.5: Defining the input page content.”|

Exercise 5.5: Defining the input page content

Before you begin, you must complete [“Exercise 5.3: Defining the iSeries GETDATA|
program invocation and parameters” on page 60| or [“Exercise 5.4: Defining the|
iSeries GETDATAS service program invocation and parameters” on page 66

Now you need to specify which of the input parameters you want to see on the
input page for this interaction that gets generated by the wizard. This is easy in
this application since you only have the customer number input field to handle.
You also have the capability to enhance the page layout by changing colors of the
page background and changing the heading. The Design the Input Form page
contains a properties table that shows all input capable parameters, and a sample
of the Web page that will be created.
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& web Interaction - custInquiry - Zl

Design the Input Form
Specify the page properties and the input parameters that the generated Web page will expose bo the user For input. %

[ |
Input parameters: I -
EA¢&] cusiorn Move up | Mﬂmer
|
Select Al I
Desslect Al
Tie Cdor
Form Bean Scope  request
&y
Poge [Pk 2

< Back Next > I Finish I Cancel I

Changing the heading

To change the heading:

1. Click the field beside the Page Title property in the Property table and type
Customer Inquiry.

2. Press Enter to apply this change to the sample page.

Now you want to change the customer number field properties.
3. Click the Fields tab on the Properties table.

This opens the field properties for the selected field in the list.

Changing a field label

To change a field label:
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i
Design the Input Form
Specify the page properties and the input parameters that the generated Web page will expose to the user for input., %
[ |
Input parameters: -
8 G | Customer Inquiry
Move down I
agnter customer numbe
Select Al l
Desslect Al
Property | value 1
LAt =a ™ l'\
Input Style: Text Enkry
Input Choices:
Size: 7
Mame in Session: CUSTHOT
Restore from Session:  False
Save bo Session: false
Get: Browser Info.: false
Page | Fisis | E
< Back | Next > I Finish I Cancel I

In the left pane of the Design the Input Form page, select CUSTNOL
Click the field beside the Label property, and type Enter customer number.
Press Enter.

N

Click Next to advance to the next wizard page.

You have specified the input and output parameters and the input parameters to
show on the input page and now you are ready to begin [“Exercise 5.6: Defining]
[the output page content.”|

Exercise 5.6: Defining the output page content

Before you begin, you must complete [“Exercise 5.5: Defining the input page]
[content” on page 73

Note: If you chose to work with a service program (GETDATAS) then you will see
the output parameters begin with the name CUST1. All the screen shots for
the remaining exercises show the parameters for the GETDATA program.

Now you can specify what data should be displayed on the output Web page
generated for you. In the right pane of the wizard you see a sample of the page
that will be generated. First, change the Input style of the output parameter
CSTRUC.CUSTNO. This will enable you to use customer number as an input
parameter to future features of your Web project.

To define the output page:
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& web Interaction - custinguiry ZI

Design the Result Form
Specify the page properties and the output parameters that the generated Web page will display to the user as output,

Output page: result. jsp =]
s o | Result Form
B9 cstauc.reeno Move down I
BI# cstruc.contac Select Al I CSTRUC_CUSTNO:
B! cstruc.crHonE CSTRUC_CUSTNA
Bfrg CSTRUC, CFAX Desstl| | CSTRUC REPNO:
4 CSTRUC.CADDR =
B9 csruc.cary CSTRUC_CONTAC:
BA1% cstruc.ccount CSTRUC_CPHONE:
Eltg CSTRUC.CZIP CSTRUC_CFAX:
@ CSTRUC,CZIPLO -
gfg L CSTRUC_CADDR:
CSTRUC_CCITY:
CSTRUC CCOUNT

Property | alue | I cstrue oz

Component Name: CSTRUC_CUS... = !

Label: CSTRUC_CUS... CSTRUC_CZIPLO:

Data Type: e

Data e S || FEEDBACK

Input Chaices:

Size: T

Mame in Session: CSTRUC_CUS.

Save to Session: False

Message Controler: false
Bage | Fes| H

cok | woes |[Crem ]

Cancel I

1. Select CSTRUC.CUSTNO.
2. Click the Fields tab.
3. From the Input Style list, select Text Entry.

By default all output parameters will be added to the Web page, but you don’t
want the data in the FEEDBACK parameter to be displayed.

Let’s go through the steps to erase the FEEDBACK parameter from the output
page.

Output page: result.jsp
Output parameters:

M9 cstruC.cusTHO
{9 csTRUC.CUSTHA
'Y CSTRUC.REPND
9 csTRUC.CONTAC
{9 cSTRUC.CPHONE
9 csTRUC.CRAX
¥ CSTRUC.CADDR
@ csTRUC.CCITY
9 CSTRUC.CCOUNT
& cstRUC.CzIP

¥ csTRUC.CZIPLO
/%, FeeoBACK

Move up
Maove down
Select All

i

Deselect all

EREERERERE

4. In the left pane of the Design the Result Form, clear the FEEDBACK check box.
This will remove it from the Web page.
You will stay on this page to specify the error handling.
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You have specified what data to show on the output page and now you are ready
to begin [“Exercise 5.7: Specifying error handling.”]

Exercise 5.7: Specifying error handling

Before you begin, you must complete [“Exercise 5.6: Defining the output page]
[content” on page 75|

Now you can specify what should happen in case a customer number didn’t match
the customer numbers in your database.

1. In the left pane of the Design the Result Form, select the FEEDBACK
parameter.

You will see the properties for this variable in the Properties table.

O efreepBack
Property I Value ] |
Component Mame: FEEDEACK
Label: FEEDEACK
Data Type: character(20)
Input Style: Label
Input Choices:
Size: 20
Mame in Session: FEEDEACK
Save o Session: False =,
Message Controller: i@
Pags |Fislds |

2. Locate the Message Controller heading in this Properties table.

& Message Control Specification 5]

Message controller: |False 0

‘Erue K‘

Parameter Yalus

Mave Up

Maove down |
CK I Cancel I

3. Click the field beside the Message Controller and set it to true.
4. Click New.
5. Set the Parameter Value to *0THER from the list.
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10.
11.

@& Message Control Specification
Message controller: Itrue 'I

I

‘Web Component | !

inquiry . jsp-*DEFAULT

Remove
[Move ug

Maove down

il

[ |

Cancel

Set the Message ID to *SELECT from the list.
This opens a Message Selection window.
Drill-down to s400a > WSSLABXX/MYMSGF > MYMSGF > CUS0001

@ Message Selection

Select a message,

ICUSOOO!: Customer number &1 not valid

—ET& Mew Connection...
= Ea s400as
Iﬂ' s400a
22 Work with libraries. ..
&3 *LIBL
o WSSLABKKIMYMSGF OBITYPE(*MSGF:*)

G'é

01: Customer number &1 not valid

| Property | value |
jin} CUS0001
Message help
Severity 0
Text Customer number &1 not valid

<< Details

(D 1]

Cancel

Click OK.

Leave the default value of the Web Component.

Click New.
Enter 0 as the Parameter Value.
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12.
13.
14.
15.

& Message Control Specification k _)g]

Message controller: |true "I

Parameter Yalus

| Message ID

| ‘Web Component I Mew |

*OTHER
0

CusoooL
*NORE

inquiry .jsp-*DEFALULT =
MRS o) Edt

Remave

Move up

el

Move down

K I Cancel I

Press Enter.

Set Message ID to *NONE using the list.
Set Web Component to result.jsp-DEFAULT using the list.

Click OK.

Here is what you just did:

e If the return value of the FEEDBACK parameter is 0, display the customer
details in the result.jsp Web page.

* Any other return value in the FEEDBACK parameter, use the message 1D
CUS0001 in the specified message file, place the Customer number input in
the message substitution variable, and display the Web page inquiry.jsp
with the error message CUS0001.

The message handling is defined.

You have specified what will happen when an incorrect customer number is
entered in the customer number field and now you are ready to begin

[5.8: Enhancing the output page.”]

Exercise 5.8: Enhancing the output page

Before iou begin, you must complete [“Exercise 5.7: Specifying error handling” on|
page 77.

Next you enhance the look of the Web page.

To enhance the output page:
Click the Page tab in the Properties table.

1.
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& web Interaction - custInquiry

Design the Result Form

Specify the page properties and the output parameters that the generated Web page will display to the user as output.

MEI? cstruc.cusTio
[ cstruc.cusTia
|9 cSTRUC.REPNOD
:9 CSTRUC.CONTAC
@ CSTRUC.CPHONE
[® cstRUC.CRA
[9 cstruc.canor
@ cstRUC.CAITY
¥ CsTRUC.CCOUNT
9 csTRUC.CZIP

@ csTRUC.CZIPLO
2, FEEDBACK

i

ONEEEEEEERE

Customer Details

CSTRUC_CUSTNO:
CSTRUC_CUSTNA:
CSTRUC_REPNO:
CSTRUC_CONTAC:
CSTRUC_CPHOME:
CSTRUC_CFAX:
CSTRUC_CADDR:
CSTRUC_CCITY:
CSTRUC_CCOUNT:
CSTRUC_CZIP:
CSTRUC_CZIPLO:

< Back I Mt > ”TI Cancel I'

2. Click the field beside the Page title and type Customer Details.
3. Click the field beside the Background Color and click the selection button on

the right side of the field.
The Color palette opens.

4. Select a light yellow from the Color palette.

cor TR

I
B0
T
5]

FEN
HE NN
EEEEN
C 0Bl I

Custom colors:

Define Custom Colors >» I

0K | Cancel |

5. Click OK on the Color palette.

6. Click the field beside the Title Color and click the selection button on the

right side of the field.

7. Select Blue from the Color palette.
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8. Click OK on the Color palette.
You notice the sample page gets updated as you choose different properties.

If you don’t like the suggested color choices, go ahead and create your own

design.

You need to modify the labels of the fields that show up on the output JSP.

9. Click the Fields tab.

10. Select each field in the top left, and for each one, change the Label value to
the values described in the table below.

i web Interaction - custInguiry x|
Design the Result Form
Specify the page properties and the output parameters that the generated Web page will display to the user as output. %
Cutput page: result, jsp LJ
- - s | Customer Details
7 g
19 csTruc.REPNO Mave down | —
E1¥ csTruC.CONTAC Selact Al |
EL# cstruc. crHONE tomer Mame:
B(® csTRuc.crax Deselact A | Srescutative Ninber
B[ cstruc.canoe
BA® cstruc.caty onfact
E[# cstruc.coount Fhone Mumber: %
12 cstRuc.czIp Bt Matchar
P CSTRUC.CZIPLO
2, FEEDBACK Address:
City:
Country:
_Property [ value |
Component Namme: Bllieallls i
Lo <
Data Type: g2
Input Style: Teut Entry
Inpet Choices:
Size: 7
Name in Session: CSTRUC_CUS...
Save ko Session: false
Message Controller: false
D 2

CUSTNO Customer Number
CUSTNA Customer Name
REPNO Representative Number
CONTAC Contact

CPHONE Phone Number

CFAX Fax Number

CADDR Address

CCITY City

CCOUNT Country

czIp Zip

11. In the left pane of the Design

CSTRUC.CZIPLO check box. You don’t need to display this variable.

the Result Form page, clear the

12. Click Finish on the Design the Result Form page.

The Interaction wizard creates the necessary files for your application:
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¢ The file custInquiry.wit is created in the project. This file reflects the data
you entered on the pages of the Web Interaction wizard for the interaction
you identified as custlnquiry. To modify these settings, double-click on the
file to open the Web Interaction wizard.

¢ The default package under the Java Source folder contains the .java files
generated by the wizard.

* The classes folder under Web Content/WEB-INF contains the .class files
generated from the java files that were created by the wizard.

You have enhanced the output page and now you are ready to begin

[Ensuring the customer number field cannot be modified.”]

Exercise 5.9: Ensuring the customer number field cannot be modified

Before iou begin, you must complete [“Exercise 5.8: Enhancing the output page” on|
page 79.

Let’s make sure that the Customer Number field on your results.jsp page cannot be
modified.

To ensure the customer number field cannot be modified:

1. In the Project Explorer, expand WebContent and locate result.jsp.

- [3 Web Site Navigation _J_uJ
%@, Web Diagram
H |§j Deployment Descriptor: wss
48 Struts
# (# Java Resources
== WebContent
(= META-INF
#-{= theme
(22 WEB-INF
- -[&] lapangePassword. jsp
[5] error.jsp
inquiry. jsp
L@ logon.jsp
-1 e gges.js

@l result.isp p
e . sp
23 wdt400br. js

; o = wsslabex.peml Y.
4| | B

2. Right-click result.jsp.
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=2 Project Explorer X

-
SE oW
v

==
- Web Site Navigation
- fey, Web Diagram

(#4685 Struts

ﬂ (8 Java Resources

EI = WebContent
E3] = META-INF
#-{= theme
Eu = WEB-INF

w-[5] error.jsp

- [51 inquiry.jsp
[ logon.jsp

) messages. is

-3 wdt400br
=1 wisslahyy

# '@ Deployment Descriptor: wss

i & changePassword.jsp

B

[5] timeout.je  Mew

QpeEn

3. Click Open on the pop-up menu.

This opens the result.jsp page on the Page Designer.

(= *result.jsp 22

-

result.jsp - Untitled *

El v | iwchwretentry = | Standard ~

'CSTRUC CUSTNA

'%result fabel_ Representanve
'%rr::sult labal Cnntact '

PR F TS P T P T P PR T PR T TS PR T

%res;Lﬂt label_Customer_ Number

Customer Details

%result label_Customer Name

Numbm-”"f STRUC_REPNO

TRUC_CONTAC ;
RUC CPHONE }

-

Atiavavaut

PR

=

Design | Source I Preview |

=

Py | Mame:
TAELE ik
1 L 2
= put typ
TD—: Size:
]li:t imcl:WTextEnkry  Initial state;
- Data | Initial value:
- Events Crientation;
- Styles
i Tool tio:
<]

QuickEdt|Servars|Conso%e|Probﬂems|l M=l

|csTRUC_custha f |

® Text O passworll O Hidden

[ pisabled ead—only )

{Default) B
[ —

-

8

4. Select the Text Entry field of Customer Number in Page Designer.

Notice the Properties view of that Text field appears.
5. Select the Read-only check box.

This prevents any modifications to the Customer Number.

6. Save your changes and close result.jsp.

You have made sure that the customer number field is read only and now you are

ready to begin [“Exercise 5.10: Visualizing the flow structure of your Web|

lapplication” on page 84
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Exercise 5.10: Visualizing the flow structure of your Web application

Before you begin, you must complete [“Exercise 5.9: Ensuring the customer number|
[field cannot be modified” on page 82.

A Web diagram is a view that helps you visualize the flow structure of a
Struts-Based Web Application. Because of the indirectness involved with a Struts
application, being able to visually see the application’s flow can help you to better
understand the application.

Struts

Before you create a Web diagram, let’s first look at what Struts is all about. First,
Struts is a set of Java classes and JSP tag libraries that provide a conceptual
framework for developing Web applications. The Struts technology is open source
and was developed as part of the Apache Software Foundation’s Jakarta project.

Second, Struts provides numerous, custom JSP tags that are simple to use but are
powerful in the sense that they hide information. The Page Designer does not need
to know much about form beans, for example, beyond the bean names and the
names of each field in a given bean.

Third, you can use the diagram editor to show all or part of a Struts application.
For example, suppose you have a three-part Struts application. One part handles
the login process, one part handles product inquiries, and a third part handles
product updates. In this case you could draw three diagrams to represent this
system, or you could draw the entire system in a single diagram. Because one
diagram can be included inside another, it would probably make more sense to
represent this Struts application using a set of three diagrams.

Now, that you know what Struts is, you can go ahead with this exercise.

You will now create a Web diagram that will show you the visual components of
the Web application you just created.

An empty Web diagram should have been generated for you during project
creation.

To create a Web diagram:

1. If you don’t see Web Diagram in the editor, in the Project Explorer view,
expand WSSLABxx.
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= {8 Struts
[+ Java Resources
== WebCantent
#- = META-INF
[#- (= theme
|: (= WEB-INF
~[&] changePassword.jsp
~[&] error.jsp
& inquiry.jsp
...... E Iogan‘jsp
) messages.js
~[&] result.jsp
[&] timeout.jsp
\;J wdt400br . js
o e =) wisslabice, poml
- l:ustlr!l:]i.nr\,r it
LB eslabeey mnenl

=

2. Locate and double-click Web Diagram.

You will now see the Web Diagram in

the editor.

.
¥SProject ... 23\ Galery| = O

[CE® »

- g
e -:iag‘r.hx -

L4l Connector Projects -]

# @ EJB Projects

= L Dynamic Web Projects

E L'D‘ wsslabixx
[ Web Site Navigati
“Gb Web Diagram

B @ Deployment Descr
483 Struts

s

= WebContent
(= META-INF
I'_'l = theme
(= WEB-INF
~[@] changePassw—

& error.jsp

- (22 Java Resources N_/

A Web diagram is a file that
of a Web application.

Add Modes from the Palette
o (click on Palette, then click ¢

e Connect nodes by dlickir
" on the two nodes to cor

Daouble click an any new noc
a wizard to create the unde

This note will disappear onc
For additional help, press F:

- [&] inquiry.jsp
& logon.jsp
) messages.js
—[&] result.jsp

| I

] - [&] timeout.jsp
< | »
— = Skl
o= Cutline 23 S 7 e
5 [=F

Now, let’s populate the Web diagram:

[ T Properties ES\Qulck Edit | Servers | )

uﬁ]

1. Locate inquiry,jsp under WSSLABxx and then WebContent in the Project

Explorer.

2. Click inquiry.jsp and drag it to Web Diagram. You will notice the cursor change

from © to %3

3. In the Web diagram, right click inquiry.jsp.
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e |
72 project ... 23\'\_ Galery | = B

ey v
[=1-L3 Dynamic Web Projects ﬂ
B wsslabo
[ Web Site Navigati
@, weh Diagram

“°. *diagram.gph X

‘iz Deployment Descr
[#-§88 Struts
[+ % Java Resources .
=] E‘; WebContent m 4 Connection
[+ (= META-INF
# (= theme ) Undo Move Object

= WEB-INF

] ;
= Red
5 changePassw W Redo
il enorjsp Edit Web Page
&l inqury.sp Edit Other >
logon. jsp
) messages.is % Delete
- result.jsp S
] timeout.jsp .
) wdt400br,js Change Description
|=| wsslabxx.pcm New »
%5 custInguiry, wit .
; 8% wsslabxee.moeml X .
| Snap C
= S ~ #lign »  Draw Selected
o= outline £2 N\ "4 =] 8
= Show Page in \Web Site Designer =
]u Elpro #3 Diagram Settings le ] Problarns_ |
| y= | L,
& Filter Settings | 550 -
Fropel  Runon server...
] des Save

Webrrageraor sy —

4. Click Draw > Draw All From on the pop-up menu.

You will now see the custInquiry interaction.
5. Right-click custlnquiry and click Draw > Draw Selected.
6. Select the result.jsp check box

& select connections to be drawn x|
= @-‘ m
O  —=CustInquiryInputForm Scope: request

== Global Forward
. [0  weint.signon.prompt-->logon.jsp
L O webint,changePassword. prompt-- >changePasswo
=-E o Local Forward
-0  session_error-->timeout.jsp
O wde_error-->error.jsp

resulk--=result.jsp

| | B

7. Click OK.

You should now see the graphical representation of the Web interaction that
you've created in a previous exercise.
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@ S

inquiry.jsp \jhje ct
id = msg _—
o) age igl

= result

result.jsp

8. Save and close Web Diagram.

You have seen the flow structure of your Struts-based Web application.

Module recap

You have completed [Chapter 5, “Module 5. Creating a Web application,” on page

You have learned how to:

e Start the Web Interaction wizard

* Create an input page that invokes the interaction

* Create an output page that displays the results of the interaction
* Get the program interface definitions

* Specify the input and output parameters

* Specify the input parameters to show on the input page

* Specify what data to show on the output page

* Specify what will happen when an incorrect customer number is entered
¢ Change the background color of the output page

* Make sure the customer number field is read only

¢ Know what Struts is all about

* View the flow structure of your Struts-based Web application

You have created your Web application. Continue to [Chapter 6, “Module 6
[Running the Web application,” on page 89|
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Chapter 6. Module 6. Running the Web application

This module teaches you how to test the Web application locally without
deploying the files in the Web project to the host server. Testing your Web
application locally includes using the iSeries Web Tools Run-time Configuration
wizard to specify the authentication and run-time values for every host program or
procedure call made by any Web interaction in the Web project. This is something
you have already done in [Chapter 2, “Module 2. Creating an RPG program,” on|
page 7] or [Chapter 3, “Module 3. Creating the RPG service program for your Web|
application (optional),” on page 23

In this module, you will:

* Check the Web perspective is open

* Locate input page of the Web application

* Invoke the Web application to run in the WebSphere Test Environment
* Test the Web application

Exercises

The exercises in this module must be completed in order:

* |[“Exercise 6.1: Opening the Web perspective’]

* |“Exercise 6.2: Finding the Web application and running it”|

Time required

This module will take approximately 10 minutes to complete.

Exercise 6.1: Opening the Web perspective
To open the Web perspective:

1. Click the Web perspective QJ icon, on the left taskbar of the workbench.

EI Remote Syste. ..

2. If there is no Web perspective icon, select Window > Open Perspective > Web
from the workbench menu.

You have checked that the Web perspective is open and now you are ready to
begin [“Exercise 6.2: Finding the Web application and running it.”]

Exercise 6.2: Finding the Web application and running it

Before you begin, you must complete [“Exercise 6.1: Opening the Web perspective.”

To test your application locally using the WebSphere test environment:
1. In the Project Explorer, expand your project WSSLABxx.
2. Expand the WebContent folder.
3. Right-click inquiry.jsp and click Run > Run on Server on the pop-up menu.
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—,

-
El=k=n
[#- (= theme :I

B (2 WEB-INF
[ changePass
~[5] error.jsp
- B [

-~ [&] logon.jsi New ’
%0 message

: COpen
[ resuljs i :

[ timeout, Open With 4
%0 wakdo0t —
i[5 weslabx: i

%) custInquiry, L= Paste

B wsslabxx.mi 3§ Delete

[#-_1 Other Projects

&L Web Services

=L Databases

- Database Servers 23 IMport...

Refactar Alt+Shift+T P

4| | 7 Export...
R . o Edit | Servers | Caonsole | Proble
o2 Outline £3 "4 5 Refresh ]—E 4
\An outline is not available. 2
Run Yalidation |
Pumb o= 13

You will see a message to select the Server to run. You will run your
application in the WebSphere Test Environment. This is shown as WebSphere

Application Server v6.0.

@ server Selection x|
Define a New Server
Chaoose the type of server to create.
How do you want to select the server?

@:hmse an existing server
(" Manually define a server

Select the server that you want to use;

=] L_— IoEalhost
{851 WebSphere application Server v6.0

Wiew By: |Host name ¥
Description: WebSphere Application Server v6.0

eset server as project default (do not prompt)

<pack | Next> || Fish |  Cancel |

4. Leave the default Choose an existing server radio button selected.
5. Make sure WebSphere Application Server v6.0 is selected under Select the
server type you want to use.
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6. Select the Set server as project default (do not prompt) check box.

7. Click Finish to configure and launch the server.

8. A Server Selection message dialog appears indicating the operation is in

progress.

Server Selection )
@ Operation in progress. .. %

| Run in Bachgromdl Cancel I Details == I

After the WebSphere server has started, your Web application input page will

display in the workbench browser.

=
Customer Inquiry
Enter customer number: |0010100|
Reset
=
Dane |

9. Type 0010100 as the Customer Number.
10. Click Submit.
This launches the generated output or result page.

a. If you see a Page not found error, go to the Servers view.
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d 3.5 Debug

Stop
-1 Disconnect £ Profile
= LI Publish

Monitoring 3

Restart Project L2

‘= Add and remave projects. .

Run universal kest client
Restart universal best dient
Run administrative console

Reconnect debug process

Quick Edit FEESERT-E0.S
[] Create tables and data sources

Server | F % Run external admin script

wWebSphere Application Server v6.0  localhost

4

=1

_‘KProp-erties

Kl | 2

b. Restart the server instance. Then go back and try the Run > Run on
Server option again; the Server sometimes needs to be restarted to pick up
the changes.

You will see the Result page with customer data appearing in the workbench

browser.
=
Customer Details
Customer Mumber: 0010100
Customer Name: Meridien Electronics Limited
Representative Number: 43443
Contact: Alfredo Bayonne
Phone Mumber: 206-865-4027
Fax Mumber: 206-865-4037
Address: 10423 S E. 30th Place
City: Bellevue, WA
Country: USA.
Zip: 98007
' Submit | Reset
i |
Done

Next, test the message handling.
11. Click the ﬂ Back button in the browser to get back to the first page.

12. Enter a wrong customer number, for example, 9999.

92 Development Studio Client: iSeries Web tools



Customer Inquiry
Enter customer number | 9999

=
Dane
13. Click Submit.
An error message appears.
=
Customer Inquiry
Enter customer number [3999
Submit | Reset
Customer number 9999 not valid
=
[

This capability is generated by the Web Interaction wizard. Remember that
you specified something for the feedback field; you specified the message file
to be accessed if the feedback field contains a non 0 value; in this case the
feedback parameter will contain the message ID to be used for the error
message.

You have found and run the Web application.

Module recap

You have completed [Chapter 6, “Module 6. Running the Web application,” on page]
You have learned how to:

* Check the Web perspective is open

* Locate input page of the Web application
* Invoke the Web application to run in the WebSphere Test Environment
* Test the Web application

Now that you have run your Web application you learn how to debug your Web
application. Continue to |Chapter 7, “Module 7. Debugging a Web application,” on|
hae 95.
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Chapter 7. Module 7. Debugging a Web application

This module teaches you how to debug a Web application. You will learn how to
set up the debug environment, use a service entry point, add and remove
breakpoints, display a variable, and view the call stack.

You will debug a Web application that invokes the iSeries GETDATA program.

In this module, you will:

* Recognize the features of the iSeries Integrated Debugger
* Start a debug session with service entry points

* Set breakpoints

* Monitor an expression

¢ Expand a thread to show every program, module, procedure and method on the
call stack at the current execution point

* Run the program to termination
Exercises

The exercises in this module must be completed in order.

* [“Exercise 7.1: Introducing the iSeries Integrated Debugger”]

* |“Exercise 7.2: Starting a Debug session using service entry points” on page 96|

* [“Exercise 7.3: Adding and deleting breakpoints” on page 98|

* |“Exercise 7.4: Displaying a variable” on page 99|

* |[“Exercise 7.5: Viewing the call stack” on page 99|

* |“Exercise 7.6: Closing the debug session” on page 100|

Time required

This module will take approximately 15 minutes to complete.

Exercise 7.1: Introducing the iSeries Integrated Debugger

The Integrated Debugger is a source-level debugger that enables you to debug and
test an application that is running on an iSeries system. It provides a functionally
rich interactive graphical interface that allows you to:

* View source code or compiler listings, while the program is running on the
iSeries system.

* Set, change, delete, enable and disable line breakpoints in the application
program. You can easily manage all your breakpoints using the Breakpoints
view.

* Set watch breakpoints to make the program stop whenever a specified variable
changes.

* View the call stack of your program in the Debug view. As you debug, the call
stack gets updated dynamically. You can view the source of any debug program
by clicking on its call stack entry.

* Step through your code one line at a time.
* Step into or step over program calls and ILE procedure calls.
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* Display a variable and its value in the Monitors view. The value can easily be
changed to see the effect on the program’s execution.

* Locate procedure calls in a large program quickly and easily using the
Modules/Programs view.

* Debug multithreaded applications, maintaining separate stacks for each thread
with the ability to enable and disable any individual thread.

* Load source from the workstation instead of the iSeries — useful if you don’t
want the source code on a production machine.

* Debug client/server and distributed applications.

The Debugger supports RPG/400® and ILE RPG, COBOL and ILE COBOL, C, C++
and CL.

In the following exercises you will be given the opportunity to learn about some of
the basic features of the Debugger.

You have been introduced to the debugger and now you are ready to begin
[“Exercise 7.2: Starting a Debug session using service entry points.”|

Exercise 7.2: Starting a Debug session using service entry points

Before you begin, you must complete [“Exercise 7.1: Introducing the iSeries|
[[ntegrated Debugger” on page 95

In this exercise you will use service entry points to debug a Web application. The
service entry point feature is designed to allow easy debugging of Web
applications that invoke business logic written in RPG, COBOL, CL, or even C or
C++. The service entry point is a special kind of entry breakpoint that can be set
directly from the Remote System Explorer. It is triggered when the first line of a
specified procedure is executed in a job that is not under debug. Service entry
points allow you to gain control of your job at that point. A new debug session
gets started and execution is stopped at that location.

To start a debug session:

1. In the Remote System Explorer perspective, expand the iSeries server icon
(s400a) if not already expanded.

2. Expand iSeries Objects if not already expanded.
3. Expand the Library List if not already expanded.
If prompted, type your User-ID and password.
4. Expand the library WSSLABxx if not already expanded.
You will see all objects in this library.
Now you will start the debug session and set a service entry point.
5. Right-click GETDATA.*pgm.rpgle.

6. Click Debug (Service Entry) Point > Set Service Entry Point on the pop-up
menu.

A message displays indicating the service entry point entry was successful.
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@iiSeries Debug Message h l(j

i

Service entry point is set successfully.

The service entry point can be refreshed through iSeries Service Entry
Point(s) view if you recompile or update the program or service program later,

I Don't show me this again,

=]

7. Click OK.
8. Click the Web Browser tab to switch back to the Web browser.
9. Type 0010100 in the Enter customer number field.

10. Click the Submit button, which will invoke GETDATA*pgm.rpgle on the
iSeries host.

At this point, the Service Entry point is hit and the debug session is started.

@ Debug - GETDATA.RPGLE - IBM Rational Software Development Platform — IDL_)EI
File Edt Sowce Compile Navigate Search Project Run Window Help
[t @ %0 -8 Q- @7 |0a- - 5[ Broung Queb
| |2 o » | A K B X EHRemote Syste...
#5Debug 32 Swws[ S ) (69=yariables 3 . Breakpo... IRel:Istars{ ? =H\f 5
- g v (|-
> 2| eS| |le|f=® W fl 4
~@ _QRNL_PRMCPY_CSTRUC = SPP:2483096C1600|
@ _ORNL_PRMCPY_CUSTNOI = SPP:2463096C160( .
S1-gP Thread:1 (stopped) il - ? _QRNL_PRMCPY_FEEDBACK = SFP:2483096C16(
= GETDATA: GETDATA: GETDATA 4] | ’
= _QRNP_PEP_GETDATA : GETDATA : = =
(l = allNumme mes o OPOCENIYE n—:nrnEj_J _4_' L‘_J =

Cuarone PETRRER. 0| Gous 5o
Line 1 Column 1 Replace Press Refresh to update view
........ 1 Foasalacastia i idaiaatann
» opoiooff = _-il
000z00 ¥
000300 * Sample RPGIV program to a
000400 o Used in WDT hands on LAB
000500 * Created by Claus Weiss
000600 * -
| | »
|
El consale X Tasl-:sllﬁertastmndﬂoq[ # | N | (2 =m

Process: 819194/QUSER/QZRCSRYS Program: GETDATA

=

n | | [ —
I ;

Notice that it also opens an instance of the GETDATA source code in the
debug editor. You now have the access to debug this source.

Let’s look at some more debug features.

You have started a debug session with service entry points and now you are ready
to begin [“Exercise 7.3: Adding and deleting breakpoints” on page 98
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Exercise 7.3: Adding and deleting breakpoints

Before you begin, you must complete [“Exercise 7.2: Starting a Debug session using]
[service entry points” on page 96.

Breakpoints are markers you place in your program to tell the debugger to stop
your program whenever execution reaches that point. For example, if you suspect
that a particular statement in your program is causing problems, you could set a
line breakpoint on the line containing the statement, then run your program.
Execution stops at the breakpoint before the statement is executed. You can then
check the contents of variables and view the call stack, and execute the statement
to see how the problem arises.

You can only set breakpoints at executable lines. All executable lines are displayed
in blue. The easiest way to set a breakpoint is to right-click on the line in the
Source view.

To set a breakpoint:
1. Click anywhere on line 8.
2. Right-click and click Add breakpoint on the popup menu.

A dot with a check mark in the prefix area indicates that a breakpoint has been
set for that line. The prefix area is the small grey margin to the left of the
source lines.

Line 8 Column 1 Replace

I. ...FFilename++IPEASFRlen+LElen+AIDewv
Qoo3o0 * Sample RPGIV program to a;l
000400 ® Used in WDT hands on LAB _-I
ooos00 * Created by Claus Weiss
000800 *

000700 * F spec for file CUSTOML3 key
2 000800 FCUSTONML3 IF E K‘D’ﬂ
«| »

[l

Click on line 32.
Right-click and click Add breakpoint on the pop-up menu.
Click the Breakpoints tab in the upper right pane of the workbench.

ook w

In the Breakpoints view right-click the breakpoint for line 8.

Here you can manage your breakpoints. You can disable, or remove
breakpoints accordingly.
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X3 ine [GETDATA.RPGLE:S]

You have set breakpoints and now you are ready to begin [“Exercise 7.4: Displaying|

a variable.”

Exercise 7.4: Displaying a variable

Before you begin, you must complete [“Exercise 7.3: Adding and deleting|
[preakpoints” on page 98|

You can monitor variables in the Monitors view. Now you will monitor the
variable CUSTNOL

To monitor a variable:
1. In the Source view double-click the variable CUSTNOI on line 22.
2. Right-click CUSTNOL
3. Click Monitor Expression on the pop-up menu.
The variable appears in the Monitors view.

If you quickly want to see the value of a variable without adding it to the
Monitor, you can place the cursor on a variable to see its value in a pop-up
window. This works well for scalars, but not for arrays or data structures.

You have monitored an expression and now you are ready to begin
[Viewing the call stack.”]

Exercise 7.5: Viewing the call stack

Before you begin, you must complete [“Exercise 7.4: Displaying a variable.”]

The Debug view in the upper left pane, lists all call stack entries. It contains a tree
view for each thread. The thread can be expanded to show every program,
module, procedure and method that is on the stack at the current execution point.
If you double-click a stack entry that has debug data, the corresponding source
will show up. Otherwise the message No Debug data available appears in the
debug editor. In the Debug view, expand the stack entry of Thread:1 if it is not
expanded already, by clicking the plus sign + in front of it.
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o x N =5
S 23| |[e o~
B 5] ‘Websphere Application Server vé,0 [WebSphere v6.0 Server]
; » | WebSphere Application Server v6.0 (WehSphere v6.0)
B 3% tmp [iSeries: Debug Job]
= ','E State: <stopped> Connection: iSeries{TM) (toras46f: 1044)
[=-4® Thread:1 (stopped)

GETDATA | GETDATA : GETDATA
_ORMP_PEP_GETDATA : GETDATA : GETDATA
CallProgram : QZRCSRYS : QZRCRPC

main : QZRCSRYS : QZRCSRYS

_C_pep : QZRCSRAYS : QZRCSAYS

g Process: 819194/QUSER[QZRCSRYS Program: GETDATA

You have expanded a thread to show every program, module, procedure and
method on the call stack at the current execution point and now you are ready to
begin [“Exercise 7.6: Closing the debug session.”|

Exercise 7.6: Closing the debug session

Before you begin, you must complete [“Exercise 7.5: Viewing the call stack” on]

To close a debug session:
1. Click Resume on the Debug toolbar.
The session will stop at the first breakpoint on line 8.
2. Click Resume again.
The session will stop at the breakpoint on line 32.
3. Click Resume again.
4. Click OK on the Program terminated window.
Next, close the Debug perspective.
5. Right-click the Debug icon.
6. Click Close on the pop-up menu.

& Debug - Web Browser - IBM Rational Software Development Pl 11 =10 x|
Fil= Edit Mavigate Search Project Run  Window Help

| £5 - |3-0-2-4Q - | & 57 [ | %5 Debug_ (4 Web
J e A= e Remnh%

q Sawers[ =0 |fVaiables (09 Breakpoints 52 S
i | &8 o= “i? v Show Text

7. Switch to the Remote System Explorer perspective to remove the Service Entry
Point on GETDATA *pgm.rpg.

8. Dirill down to s400a > iSeries Objects > Library List > WSSLABXX >
GETDATA *pgm.rpg

9. Right-click on GETDATA *pgm.rpg
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10. Click Debug (Service Entry) > Remove Service Entry Point on the pop-up

menu.

You have run the program to termination.

Module recap

You have completed |[Chapter 7, “Module 7. Debugging a Web application,” on|
You have learned how to:

Recognize the features of the iSeries Integrated Debugger
Start a debug session with service entry points

Set breakpoints

Monitor an expression

Expand a thread to show every program, module, procedure and method on the
call stack at the current execution point

Run the program to termination

Now that you have debugged your Web application, you learn how to create an
informative error page using Page Designer. Continue to [Chapter 8, “Module 8|

[Adding an error page,” on page 103/

Chapter 7. Module 7. Debugging a Web application 101



102 Development Studio Client: iSeries Web tools



Chapter 8. Module 8. Adding an error page

This module teaches you how to create an informative error page using Page
Designer for when a customer enters an incorrect customer number. This way, the
customer won't just be given an error message, but will have a more informative
and helpful response from the Web Application, which is easy to customize. You
will also learn how to add the error page to your existing Web application using
the Web Interaction wizard and to use the RSE perspective to modify the program
or service program to call the error page. In this module, you will:

* Create an error page using Page Designer

¢ Change the Web interaction to use the new error page

* View the result of adding flow control to the Web application
Exercises

The exercises in this module must be completed in order.

* [“Exercise 8.1: Creating the flow control page”]

* |“Exercise 8.2: Modifying your Web interaction” on page 105|

+ |“Exercise 8.3: Testing the new error page” on page 111|

Time required

This module will take approximately 20 minutes to complete.

Exercise 8.1: Creating the flow control page

First you need to create the error page using Page Designer.

To create the error page:

1. In the Web Perspective, expand your project and drill down to the Web
Content folder.

TN, Navigator | Galery| = O A

TER v fReey
= e available
# ‘i3 Deployment Descriptor: wsslabxx Zi
() {8) Struts
# (% lava Resources
SRS '=bConte
! B [ Project...

[ OEE =
| B weB-InF Gz OB [JY Java Project
[ changepP - Paste £ Package
(& ervor.jsp 3 Delet g
e o
- [&] inquiry.j: SR
[ logen.is;  Refactor Alt+shift+7 » €% Interface
9 message ) Source Folder
- [&] results.j 22y Impart... =
-] timeout. 3 Expart. . [ Folder
4 w400k " .
£57 HTMLIXHTML File

! . = | wsslabx: -.f Refresh
L) custInguiry

2. Right-click the Web Content folder and click New > JSP on the pop-up menu.
The New JSP File page opens.
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@i New ISP File i x|

ISP File )
Specify a name and location For the new 1P file, ¢ ; \

Folder: ] JwsslabsoWebContent Browse. .. |
oot 8 o cco ool

Matkup Language: IHTM. :!
Options: [” Create from page template %

™ Creats as ISP Fragment

= lise 2ML Style Syrtax

Model: IN::ne
Generate a new blank JSP page.

Le bl Le

[~ Configure advanced options

= Back I [Jext = l@l Cancel I

3. In the File Name field, type RecordNotFound.
4. Click Finish.
The Page Designer automatically opens.
Your window will look like this.

8
RecordMotFound.j. ..cordiotFound. jsp Fl= | BODY = Standard =

@ RecardhlotFound.jsp. X

Place content here.

Design | Source | Preview |

5. Click on the words Place content here. and change it to something like Sorry,
there is no record for that customer number.

Press Enter.
Type Please check the number and try again.
Highlight the words try again and right-click.

© ® N

Select Insert Link on the pop-up menu.
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The Insert Link window opens.
10. Click Browse next to the URL field.
11. Click File on the pop-up menu.

The File Selection window opens.

_ioi

Select a file:

11> wsslabio
Bl (= WebContent

(= META-INF
(= theme
# (= WEB-INF
) messages.js
) wdt400br js
5 changePassword. isp L
«[@] error.jsp

- ingquiry.jsps

T Togon 5P

RecordiotFound. jsp

results.jsp

5] timeout.jsp

LB wsslabie. peml

'ﬂ‘ Cancel I

12. Select inquiry.jsp.
13. Click OK.
14. Click OK in the Insert Link dialog.
You have completed creating the flow control page.
15. Save and close the file.

You could spend more time customizing this page, but for the purpose of this
exercise you will leave the page as is.

You have created an error page using Page Designer and now you are ready to
begin [“Exercise 8.2: Modifying your Web interaction.”]

Exercise 8.2: Modifying your Web interaction

Before you begin, you must complete [“Exercise 8.1: Creating the flow control page”|

Now you need to change the Web interaction to use the new error page.

To modify the Web interaction:
1. Expand your project WSSLABXxx if not already expanded.

2. Right-click custInquiry.wit and click Open With > iSeries Web Interaction
Wizard on the pop-up menu.
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[0 % v =0

~

mwl

- [2] struts-bean.td
-~ [E] struts-config.xmil
[Z] struts-html.td
[Z] struts-logic.tid
2] struts-nested.tld
-~ [E] struts-template.tid
[Z] struts-tiles.Hd
& web,xml
changePassword. jsp
Error. jsp
inquiry.jsp
logon. jsp
messages. js
RecordhotFound. jsp
result.jsp
timeout.jsp
wdt400br . js
wisslabee, peml

-] Other Projects
L Web Services

# L[ Databases
) Database Servers

Page Dat: '
¥ Delete

o= outline £3
An outling is not available.

Refactor Alt+Shift+T »

=

[ Text

|~ System Editor
| =| In-Place Editor
Default Editor

Editor

The Web Interaction wizard opens.

The name and location of your Web interaction are already specified.

3. Click Next to add a new output page.

& web Interaction - custInquiry

Specify the Input and Output Pages for your Web Interaction

You can use previaushy designed input and output pages for this Web interaction or you can have the wizard gererate them,

7 Generate input pag=
' Use input pages:
Jinquary. jsp

0" Generate outpit pages
' Use oukput pages:
Jresulk 15p

[ | Gererate inpUtloutpit pages Using & peas temolats

< Back

net> [ Fen |

Cancel

4. Next to the result.jsp section, click Add.
The Output JSP window opens.
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& Output ISP x|

Choose output 15
Lol i t

[ error jsp
[ inquiry.jsp
[ logon.isp
[5] results.jsp
" -[) timeout.jsp

() ] e |

5. Select RecordNotFound.jsp.
6. Click OK to add the new output page.

& web Interaction - custInquiry i x|

Specify the Input and Output Pages for your Web Interaction
You can use previaushy designed input and oukput pages For this Web interaction or you can have the wizard generate them, %

Page preview:
| Generate input page i

+ Use input pages:
[inquery.sp

" Geqerate output pages
v Use output pages:

Jresulk 15p
JRecordhiotFound. jsp

7. Click Next in the Web Interaction wizard.

You will re-use the Feedback parameter to control which page the Web
Interaction will send next after it performs its action; the result.jsp or the
RecordNotFound.jsp. So you don’t have to add another parameter or change
the parameters, you just change the values the feedback parameter returns
depending on whether a customer record was found or not found.

8. Click Next since you don’t need to define the program interface.
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This opens the Input Parameters page.

9. Click Next again since you don’t need to change any input parameters.

This opens the Output Parameters page.

Map and Link the Output Parameters to the Dutput Fields
Link the parameters in your progeam to the Fields on your Web page. The value of the output parameter in your program s passed to the

corresponding eutput fields on your 'Web page.

Output parameters:
[# cstruc.custvo
| cstrRuc.cusTia
[# cstRuCREPNO
[ estruc.conTac
| cstruc.crHONE
[# cstruc.crax
[# cstruc.capor
|# cstRuc.cary
[# cstRuc.coount
[# cstuc.czip

[ BUCLZIPLO

FEEDBACK

_Property | value

Link

T—

Data Type: character(20)
Name in Session: FEEDBACK
Save to Session: False

Flow Controller: fals
Message Controller: @

Parameters | Fields | [#3 resutisp
CSTRUC.CUSTNG  result,jsp-CSTRUC C.. 18] MRecordnctFound.ssp
CSTRUC.CUSTNA result.jsp-CSTRUC_C..

CSTRUC.REPNG result,jsp-CSTRUC R

CSTRUC.CONTAC result,jsp-CSTRUC_C

CSTRUC.CPHOME resukt.jsp-CSTRUC_CP...

CSTRUC.CFRAX result,jsp-CSTRUC_CF..,

CSTRUC.CADDR result,jsp-CSTRIC_C

CSTRUC.CCITY result, jsp-CSTRUIC

CSTRUC.CCOUNT result, jsp-CSTRUC C...

CSTRUC.CZIP resiukt,§sp-CSTRUC_CZIP

_Property

| value

10. Select FEEDBACK under the Output Parameters list.
11. Change the Message Controller property to false. Click OK.

12. Select feedback under the Output Parameters list again.

Now a Flow controller property is added to the Properties table.
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& web Interaction - custInquiry

Map and Link the Output Parameters to the Dutput Fields

Link the parameters in your progeam to the Fields on your Web page. The value of the cubput parameter in your program s passed to the

corresponding eutput fields on your 'Web page.

Output parameters:
[# cstruc.custio
| cstrRuc.cusTia
[# cstrRuc.REPNO
[ estruc.conTac
| csTRUC.CPHONE
|# cstRuC.CRax
[# cstruc.capor
[# csRuc.cay
[# cstRuc.coounT
& csmruc.cap

= ZIPLO
rewesc)

L T S [P
Parameters | Fields | [#3 resutisp
CSTRUC.CUSTNO  result.jsp-CSTRUC C... 18] MRecordnctFound.ssp
CSTRUC.CUSTNA result.jsp-CSTRUC_C...

CSTRUC. REPHG result, jsp-CSTRUC_RE...
CSTRUC.CONTAC result.jsp-CSTRLC_C...
CSTRUC.CPHOME resul.jsp-CSTRUC_CP...
CSTRUC.CFRAX result,jsp-CSTRUC_CF..,
CSTRUC.CADDR, resuk, jop-CSTRIJC_C...
CSTRUC.CCITY result jsp-CSTRUC_C

CSTRUC.CCOUNT result jsp-CSTRUC_C..

CSTRUC.CZIP resuk jsp-CSTRUC_CZIP

Property | vaue J
Data Type: character(20)
Name in Session; FEEDBACK
Save to Sessian: False
Flow Controller: @
Message Conkroller: False k

< Back

_Property | vaiue

13. Change the Flow Controller property to true.

14.
15.
16.
17.

18.

19.

The Flow Control Specification dialog opens.

@i Flow Control Specification

Flow Controller: Itrue Tl

k

Ix

|

Value | output 15

0} results. jsp

OTHER RecordiotFound. j
b [Record d.jsp

[ o ]

Maove up

Move down

Cancel

el

The value *0THER is already in the Value field for the /errorjsp.
Click the /error.jsp field to change the Output JSP page.
Select RecordNotFound.jsp from the list.

Click New.

This creates a new flow condition. The default page is result.jsp.
The value 0 is already in the Value field with result.jsp in the Output JSP

field.
Click OK.
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This will set the flow control such that if the value of Feedback is 0, then the
program will output the customer information to the result.jsp page and

display it.

However, if the customer number doesn’t exist in the database, the Feedback
value will be something else other than 0, and instead of displaying a message
near the input field, it will show the user the RecordNotFound.jsp page for a
more helpful response.

20. Click Finish on the Output Parameters page to apply your changes to the

Web Interaction.

& web Interaction - custinquiry I ﬁl
Map and Link the Output Parameters to the Dutput Fields
Link the parameters in your progeam to the fields on your Web page. The value of the output parameter in your program is passed to the
corresponding eutput fields on your 'Web page.
Lirk | Unlink. I
Qutput parameters: Output page held
[# cstruc.cusmio Parameters | Fields | = 3] result.isp
[9 CSTRUC.CUSTNA CSTRUC.CUSTHO result,jsp-CSTRUC C... 9] MRecordnctFound. sp
L;} CSTRUC.REPNG CSTRUC.CUSTNA result.jsp-CSTRUC_C...
; A CSTRUC.REPNG resul jsp-CSTRUC RE...
F% CSTRUC.CONTAC CSTRUC.CONTAC result,jsp-CSTRUC_C...
l{f CSTRUC.CPHONE CSTRUC.CPHOME resuk,jsp-CSTRUC_CP...
[# cstRuc.crax CSTRUC.CFAY resuk,jsp-CSTRUC_CF...
D oruccon S T
,\_ g resilt jsp- C
2 csmuc.cary CSTRUC.CCOUNT _ resul jsp-CSTRUC_C
12 cstruc.coounr CSTRUC.CZIP result fsp-CSTRUC_CZIP

[# cstruc.czip
[2 cstruc.cairlo
| FEEDBACK
_Property | value
Data Type: T:H;a:tar(aﬂl
Hame in Session; FEEDBACK
Save o Sessian: False
Flow Controfler: true

_Property

| vslue |

(G| _cwes |

You have changed the Web interaction to use the new error page and now you are

ready to begin [“Exercise 8.3: Testing the new error page” on page 111
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Exercise 8.3: Testing the new error page

Before you begin, you must complete [“Exercise 8.2: Modifying your Web|
finteraction” on page 105 |

Now that the flow control is in place, if you enter a wrong customer number,

= |
Customer Inquiry
Enter customer number | 9999
]
Dane

you will get the error page instead of a message.

=
Sorry, there 13 no record for that customer number.
Please check the number and try agam,
7 |
Dane

Now follow the instructions below to run the modified project on the WebSphere
Test Environment to see the result of adding flow control to your Web application.

The server should still be running from the last time you ran the Web application.
Every time you make a change to the Web application, you need to restart the

server to pick up the changes.

To restart the server:
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d 3.5 Debug

Stop

b Disconnect £ Profile

“ L Publish
Monitoring 3

Restart Project L2

‘= Add and remave projects. .

Run universal kest client
Restart universal best dient
Run administrative console

fProp-erties Quick Edit m ¢ Reconrect debug process

_ [] Create tables and data sources

=1

dl | |

1. Click the Servers tab to open the Servers view.

2. Select the server instance. Right-click and click Restart on the pop-up menu.
The server instance should restart.

3. In the Web perspective Project Explorer locate the Web Content folder, and
right-click inquiry.jsp.

B2
B (= WEB-INF
[ changePass

E srror.jsp
&
-[5] logon.js;  Mew :
%) message
$ Open
~[&] result.js OD ith >
~[&] timeout, Peny
9 wdtdoot o o
=| wsslabx, B

L% custinguiry, |- Paste
; 59 wsslabxx.mi 3¢ Delete
-0 Other Projects
#-L3) Web Services Refactor Alt+shift+T P
#-L[) Databasss
- Database Servers 23 IMport...

4] | 7 Export...
R . o Edit | Servers | Caonsole | Proble
o= Outline £2 b 4 1’:‘,:. Refresh ,E |
\An outline is not available. | 4
Run Yalidation |
Run Fl 8 tRunons
Pumb o= 13

4. Click Run > Run on Server on the pop-up menu.
You have viewed the results of adding flow control to the Web application.

Module recap
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You have completed [Chapter 8, “Module 8. Adding an error page,” on page 103,
You have learned how to:

* Create an error page using Page Designer
* Change the Web interaction to use the new error page
¢ View the result of adding flow control to the Web application

Now that you have added an error page to your Web application to handle
incorrect customer numbers, you can learn how to customize your input page.
Continue to [Chapter 9, “Module 9. Enhancing the input page using Web tools,” on|

|Eage 115.|
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Chapter 9. Module 9. Enhancing the input page using Web
tools

This module teaches you how to use the Web tools in the workbench to update the
input page of your customer inquiry Web application. The input page named
inquiry,jsp is one of the files created by the Web Interaction wizard. This page is
very plain. You will learn how to use Page Designer and some related Web tools in
the workbench to add some color to the input page, as well as add some pictures
to make it a more interesting Web page.

In this module, you will:

* Locate the Web application input page and start Page Designer
* View the title of the input page

* Add a style to the input page

* Preview the new style for the input page
 Start WebArt Designer

* Create a logo

* Resize the logo

* Save the object as a WebArt object

¢ Save the object for a Web page

* Place the object on the Design page

* Add a company name to the input page
¢ Add an image to the input page

* Add a marquee to the input page

* Apply color to certain areas of text

Exercises

The exercises in this module must be completed in order

* |“Exercise 9.1: Opening Page Designer” on page 116|

* [“Exercise 9.2: Working with page properties” on page 117

* |[“Exercise 9.3: Linking a cascading style sheet to the Web page” on page 118|

* [“Exercise 9.4: Designing and adding a logo” on page 120|

* |“Exercise 9.5: Adding a heading 1 tag to the page” on page 129

* |“Exercise 9.6: Adding a picture to the page” on page 131

* [“Exercise 9.7: Adding moving text to the page” on page 132|

* [“Exercise 9.8: Changing the text color” on page 136|

Time required

This module will take approximately 30 minutes to complete.
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Exercise 9.1: Opening Page Designer

The first step is to locate the inquiry.jsp file and to start Page Designer. In Page

Designer you will link the page to a cascading style sheet that comes as a sample
with the workbench.

To open the Web perspective:
1. In the workbench, open the Web perspective:
You should now have the Project Explorer in your workbench.

*% Praject Explorer X - ==

BiES -
%, \Web Diagram -]
~i23) Deployment Descriptor: wsslabx:
& struts
% Java Resources
= ‘WebContent
# = META-INF
# (= theme
(2 WEB-INF
& changePassword.jsp
o .Jsp
i inquiry.js
& logon.jsp hew ’

) messages
B Rmmm
[ results.s Open Wikh 2

2. Expand the WSSLABxx web project.
Expand the Web Content folder.
4. Right-click inquiry.jsp and click Open on the pop-up menu.
[ @ naunysp < 5
inquiry.jsp - Untitied E] - | Boov - | standard -

&

[-&-@

w

E‘ustomer Inquiry

E%inquiry.lahel_Enter_custnmEr_nmnher I

5 '

“inquiry.button.submit | %inquiry.button.reset |

+ First message
+ Second message
+ Third message

Source ] Preview |
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The Page Designer appears in the upper right pane of the workbench and
shows the inquiryjsp page as the Web Interaction wizard created it.

Make sure that you are on the Design page in Page Designer.
5. Click the Design tab.

You have located the Web application input page and started Page Designer and
now you are ready to begin [“Exercise 9.2: Working with page properties.”|

Exercise 9.2: Working with page properties

Before iou begin, you must complete [“Exercise 9.1: Opening Page Designer” on|

Next you move the form down.

To work with page properties:
1. Click underneath the heading Customer Inquiry.

@ *inguiry.jsp X% =
inquiry.jsp - Untitled * Elr | po- Standard =
Customer Inquiry

J

| Iy

Al

]

o

_________________________________________________________________________________________________

+ First message
+ Second message
+ Third message

Design | Source | Preview|

2. Press Enter number of times as shown above.

3. To change the page properties, right-click the background of the inquiry.jsp
page in Page Designer.
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of Cut
ﬁ Copy.
B raste
3 Delete

Save

Insert 4
J5P 4
47 Tnsart Link..., CtrHQ

Page Properties. ..

Style R »

Embedded Document 4

Swikch Active Document. .,

| Properties CtriH+-Al+Enter
Layout Mode »

=] Run to Line 4R,

‘Eﬁ &dd to Srippets, .,

|5l Edit Events

4. Click Page Properties on the pop-up menu.
The Page Properties window opens.

x

Page Infarmation | Meta Info | J5P Tags |

Page title: Customer Inquiry

Base URL:

Default target: |

L L«

[yt et 150 10646{Unicode(UITF-6)I%

This window allows you to change some of the page properties.

For example you could change the title. When this page is shown in a browser,
the Window title bar of the browser will display Customer Inquiry.

You have viewed the title of the input page and now you are ready to begin
[“Exercise 9.3: Linking a cascading style sheet to the Web page.”|

Exercise 9.3: Linking a cascading style sheet to the Web page

Before iou begin, you must complete [“Exercise 9.2: Working with page properties’]

Now you will add a style to the input page. You can use a style that is used in
your company or you can use one of the sample style sheets that are provided in
the product.
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To link a style sheet to an input page:

J f3 T L_EH J J e 5 Bw
J“ I U A KA B = = [T | j{i‘; [¢] aﬂemutewste...

858 Q- ™% | - - -

-
Project Explorer Gallery &3

’3"\:’1 =)

|8 Image

(L HTML Tags
[=! Form Tags

[ 35 Tags

. iSeries W..,
Bstruts HT...
539 struts Be...
e struts Lo...
—|rage Te...

| web site...

a
d
¢ Foata =»
4 8 Web
n Service
|| Y
[ | » Session

ﬁignESa:ceIPrwiswl bean
Relational
/ T Properties 53 _Quick Ed|t| i ='m %Rm,d

— w || EfjRelational

T Record List

[Attributes Mo attribute is available. & JavaBean

creamsodal,

,gz? | wsslaboex/\WebContent finguiry. jsp

B

Click the Gallery tab, if the Gallery view isn’t already displayed.
Click the Style Sheet icon in the Gallery list.

Click the Thumbnails tab in the left bottom stacked view in the workbench.

You should see thumbnail icons of all the styles available as shown above.

In the thumbnail view, scroll down to the bottom, until you see style sheet
denim001.css in the list, or select a style sheet that you like best.

Click the thumbnail picture of denim001.css.

Hold the left mouse button down and drag the mouse cursor to the Page
Designer window.

b
The cursor will change from this shape > , to this shape*# . When the
latter cursor shape appears in the Page Designer window then, let go of the
mouse left button.
After a short while the Style sheet properties will be applied.

Click the Preview tab.

You will see the colors in the page have changed to the style sheet definitions.
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@ *inguiry.jsp X &

inquiry. jsp - Customer Inquiry * 2 ]

Yinquiry. button. submit Yeinguiry. button.reset |

« Firstmessage
« Second message
« Third message

Design | Sourcel Previ

8. Click the Design tab to get back to the Design page.

You have added a style to the input page and previewed the new style for the

input page and now you are ready to begin [“Exercise 9.4: Designing and adding a

Exercise 9.4: Designing and adding a logo

Before you begin, you must complete [“Exercise 9.3: Linking a cascading style sheet|

[to the Web page” on page 118

Now that you have the overall Web page look specified you will use the WebArt
Designer to create a Logo that you then will add to this page.

Starting the WebArt Designer

To start the WebArt Designer:

@i Web - inquiry.jsp - IBM Rational Software Development Platform = |I:I|£I
File Edit Toolbar Insert JSP Format Table Frame Page @ MNavigate Search Project Run  Window

Heip Launch Extetnal Web Browser »
|/ | o7 spell check... Shift+F7
] I u A LR :- = = = |3 |4 |= Validate HTML Syntax

: Conwvert ko XHTML. ..
B Q- |®™s |0 -0
4 We i-‘ er
Project Explorer | [ Gallery £3 =l & inuin) B webart Designe R
- &Y Image i | d AnimatedGif Designer

. Make sure the Page Designer is in focus.
2. Click Tools > WebArt Designer in the workbench menu.
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The WebArt designer opens.

@ Untitled - WebSphere Studio WebArt Designer ;’Qlﬁ]
Fil= Edit Wiew Object Tools Help
josER|srERxE s - o EoEE e e Ha
B By
ax O. = & x
(8 Webdrt & Gallery | -]
D Q = | 7®
Button Rollover ~ Shapes AN I -
Text: '\! @ -
|- ~ &- ol
| &a
e 0 l
RE P
Blews) | INDEX | {20 | . o®
R | 28 v
Setup Insert — Rl L'J =
For Help, press the [F1] key. | | 4

The WebArt Designer shows the Template Gallery on the left, where you find
samples of logos, buttons, rollovers, images and more. The large white area in
middle of the dialog is the canvas that is used to work with objects that you
want to create or change. Now you will create a logo from scratch.

You could also select one from the template gallery as the base for your own
logo.

Creating the logo

To create the logo:

1. Click the Create Logo button above the canvas or click Object > Create Logo.
The Logo Wizard opens.
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Logo Wizard {Specify Text - 1/4) ] _)_(_l
BH
|B M -
(I SSLABRY ) 2l
zf?ﬁ{r
;I t_?}'&ﬁf i.‘-{-.!—;;\:-
— Fant
Font name:
Font size:
Line ] 3 Character I E
spacing: e fi spacing: <
Sl Alignment
(220 C Lei
@taﬁc @:enter
[ Stikethrough " Right
[™ Underine _Diection
W Antisiias [ Vertical
Hep |

2. In the Text field, type your company name and in the next line in the Text
field, type WSSLABxx.

3. In the Font name list, select Comic Sans MS.
4. In the Font size list, select 46.
5. Under Alignment, select the Center radio button.

Notice in the upper right corner of the dialog, a sample of the logo as
specified is displayed.

6. Click Next to go to the next page of the wizard.
The Select Color page opens.
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Logo Wizard {Select Color - 2/4)
EEM)
sl
< Back Next > Cancel I Help I

7. Select the gradation type button; the middle one of the three type push
buttons.

Tip: The other buttons select color types: solid and textured.

8. Select beer from the colors available, or any other color you like best, just
scroll through the list to find a gradation you like.

Tip: You can change the colors by clicking the Others button on this dialog
and create you own gradation.

9. Click Next to go to the next page of the wizard.
The Select Outline page opens.
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Logo Wizard {Select Dutline - 3/4)

Edge width:

Edge color: -l

Transparency: i I IJE: %

|||||||||||

Bulge for edge: ’E- £|

<Back Next > Cancel |  Hep |

10. Select the Seal outline from the list, or any outline you like best.

11. Click Next.
The Select Text Effect page opens.

Logo Wizard {(Select Text Effect - 4/4) _X_I

a

Shadow

4

~ Options

Embossment
strength

Embossment
direction:

<Back Finish Cancel |  Hep |

12. Select the Emboss text effect, or one that you like best.
13. Click Finish.
You return to the WebArt designer window.
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Resizing the logo

To resize the logo object on the canvas:
1. Click the logo object to select it.

2. Move the cursor to the rectangle at the right bottom corner of the object; watch
the cursor changing shape.

3. Drag the rectangle up and to the left so the object becomes smaller.
Saving the object as a WebArt object

Now you need to save this object. First save it as a WebArt object. This allows you
later on to work with the object again in WebArt Designer, but you can’t use that
format for your Web page.

To save this object:
1. Click File > Save Canvas As on the WebArt Designer menu.

The Save Canvas As window opens. Make sure you see the WebContent folder
in the Save Canvas As window.

/x|
Save'u'ﬁlr_"? WebContent ;I « @& ek -
IMETA-INF

itheme

|-5) WEB-INF

File name: Imylagu Save

Save as lype: |Weh¢\rt files (% mif] j Cancel

I™ | Include Canvas

2. In the File name field, type mylogo.
3. Click Save.
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Now you need to save the object in a form that can be displayed on a Web
page.

Saving the object for a Web page
To save the logo for a Web page:
1. Click the logo object on the canvas.

2. Click File > Save Wizard for Web from the WebArt Designer menu.
The Save Wizard opens.

Save Wizard (Specify Objects) - 1/3

3. Click the Save the selected object radio button.
4. Click Next.
The Select File Format page opens.
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Save Wizard (Select File Format) - 2/3 5]

Select a format for the image file.

IF

 JPEG

" PNG

IF file, you can reduce its file size. This format is suitable for
mages that do not require many colors, such as line drawings or
raphs.
Enu can make pait of an GIF image kiansparent.

Eghfrs format can handle only 256 colors, By saving an image as a

This format iz in general use on the Intermet because of itz small file
size and inconspicuous image degradation. This format is suitable
for full-color images, such as photos taken with a digital camera,
You cannot make a part of a JPEG image transparent.

This format maintains the quabty of an image, but the file size
becomes larger than that of a JPEG. This format is suitable for
full-color images whose quality is important, such as computer
graphics.

“'ou can make a pait of a PNG image transparent; however, only a
few browsers can handle it comectly.

< Back Next > Cancel Help

5. Click the GIF radio button.
6. Click Next.
The GIF Format page opens.

Save Wizard (GIF Format) - 3/3 i l(]

[Driginal image] [Image to be zaved]

File size before; 23364 bytes
File size after: 4298 bytes
~ Palette ~ Properties

= Use the palette for the curent file D& WV Tiansparent .'é,;l
% Use the optimized palette I~ Interlace

Colors: IZSB colors "]

~ Background color
Dither  |'es v
Iﬂdnl of the Carvas * I
< Back Finish Cancel Help

7. Click Finish.

Chapter 9. Module 9. Enhancing the input page using Web tools

127



The Save As window opens.

Saveas 2lx
Save in: | |7 WebContent ﬂ « @ ek -
)META-INF

)theme

) WEB-INF

%] denimo03bu. gif

File name: |rny|ugd Save

Save as ype: |GIF files [".gif] LI Cancel

4

Make sure the directory is pointing to the Web Content directory in the
workspace where your Web project is located.

8. In the File name field, type mylogo.
9. Click Save.
Close the WebArt designer.
10. Select File > Exit from the menu.

You return to the workbench in the Web perspective and see the Project
Explorer.

Placing the logo on the Design page

To place the logo on the Design page:

1. Make sure you switch from the Gallery view to the Project Explorer.
2. Expand the WSSLABxx Web project.

3. Expand the Web Content folder.

*% Project Explorer % Galery] =la
mHES -
&5 {ﬁ} Struts =
[+ [# Java Resources
[ERESY YWebConten [\\\‘S
#- (= META-INF

i [+ (= theme
| E-= WEB-INF
~[&] changePassword.jisp
8| denim001.css
¥ denimo03bu.gif
[ error.jsp

~[&] resuks.jsp
e =

The mylogo.gif file should appear in the list as shown below. If it doesn’t
appear, the list might need to be refreshed.

4. Right-click the Web Project WSSLABxx folder icon.
5. Select Refresh.
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Hopefully you can see the file now in the Web Content folder, if not, go to
Windows Explorer and search for the mylogo.gif on your hard drive. Move it
to the Web Content folder in the product workspace. If you didn’t use the
default location as shown above, do a search for the workspace and the
WSSLABxx directory in it. Move the mylogo.gif file into the Web Content sub
directory under the WSSLABxx directory. Now you can take the logo and put it
on your Web page that is still open in Page Designer. If Page Designer has been
closed just open the inquiry.jsp file.

Note: Make sure your are on the Design page, not the Preview page.
In the Project Explorer view select the mylogo.gif file.

Hold the left mouse button down.

Drag the file to the upper left side in the Page Designer window.

© o N

Release the mouse button.
The logo is placed on the Design page.

2
¢S project Explorer ﬁ@\ Galbrvl = 0| Rel ﬁmkﬂw_._js _
P = = = 1 |
E E 5 ™ |Jinal feslabogWebConkentfinguiry jspfd ™
{8 Struts -] -

|TL5 Java Resources
[=h-(= WebContent
(= META-INF
(= WEB-INF
- changePassword.jsp
-~ 8| denim001.css
- [&] denim003bu.gif
~[&] error.jsp
~[&] inquiry.jsp
logon.jsp

=
: 4| | »
- [&] RecordhlotFound.jsp Design | Source | Preview |
- [&] results.jsp ..'_.[

; ’D Properties &% . Quick Edit | 2 = E\
(“memmans 23N Cllent...|”3 = E} —

You have started WebArt Designer, created a logo, resized a logo, saved the object
as a WebArt object, saved the logo for a Web page, placed the object on the Design
page and now you are ready to begin [“Exercise 9.5: Adding a heading 1 tag to the|
I' 2

Exercise 9.5: Adding a heading 1 tag to the page

Before you begin, you must complete [“Exercise 9.4: Designing and adding a logo”]

Now you want to insert a heading below the logo.

To add a heading 1 tag:
1. Position the cursor just below the logo at the first BR tag.
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@i Web - inquiry.jsp - IBM Rational Software Development Platform
File Edt Toolbar 'u@ J5P Format Table Frame Page Tools Mavigate Search Pro

Help 7 link... i+
| 47 Anchor... o g_fr
|B 7 U &  ImageFie v| | &8 B EBRe
BE | Q- Background Image File >
1.7] Background Music 4
EE' Praoject Explorer m
FE Free Layout Table
= Textcel |+ | m6 v | Standa
=688 Stru ey
B (B Jave Normal Ctrl+0
Bz Wek v
iy
; g | E Table.., Chrl+T
# (= * — Horizontal Ruls Headng3  Curl3
@ Heading 4 Chrl+4
-8«  Formand Input Fields > Heading 5 Chl4S
' ' < Seript Heading 6 Chrl+6

2. Click Insert from the workbench menu.

3. Click Paragraph > Heading 1 from the pop-up menu.
A frame appears that allows you to enter text.

4. Enter your company name.

@ *inquiry.jsp X =

inquiry. jsp - Customer Inquiry * Fl~ | H1 = Standard -

|»

;

IBM Laboratory

4
d
+
+
4

Design | Source | Preview |

Now you want to use one of the sample pictures that comes with the product
and place this picture on the page.

You have added a company name to the input page and now you are ready to
begin [“Exercise 9.6: Adding a picture to the page” on page 131
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Exercise 9.6: Adding a picture to the page

Before you begin, you must complete |“Exercise 9.5: Adding a heading 1 tag to the|

[page” on page 129/

To add a picture to the page:

1. In the Project Explorer, click the Gallery tab.

@ Web - inquiry.jsp - IBM Rational Software Development Platform i
File Edit Toolbar Insert JSP Format Table Frame Page Tools Mavigate Search Pruﬁact Run  Window

Help
i [ e s alow
]B:yxat;:}_;gq—i =S | &7 [ EFRemote Syste...
|8 & Q- @9 | - - -
oot (i D)= 0| RN, DR
S8y Imaoe g [l v | me - | standerd - ||[E0HTMLTags
(0 Banner TN
(] Bullet -:l ifm‘qhgs
() Button EP Tags
3 Icg i&ﬁcﬂes W |
@’ Struts HT..,
il _ | B3 struts e...
~ [ Photo b
(2] Theme BS 3'_"“ i
(= Title \—Page Te.,,
[ Wallpaper i%“"!h Site...
B @ Webart Data  *|
[+ Multimedia —
$3) Style Sheet £ Web
~ 2 Page Template Service
~l| (gE®B
< lrl Session
esign | Source | Preview | bean
Relational
ClProperties 53 . QuickEdk | ™ =0) Eﬁmw
= w || EQjRelational
Record List
BODY File: u013ce| @ JavaBean
P Aleernative text:
&) MG Mame:
- Image Layout
- Image Map
Text
Jd | 0

| &7 | wsslabxxfWebContent/inquiry.jsp

2. Expand the Image folder.

3. Select the Illustration folder.

4. On the Design page beside the Gallery view select one of the sample
illustrations, for example, use file u013cut.gif.

5.

Drag the picture onto the Design page beside the logo.

The Design page now contains a picture.
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™
:

inquiry. jsp - Customer Inquiry * LA |

.

IBM Laboratory *

|

Finquiry label_Enter_customer_number

—]

%inguiry. button. submit I %inguiry. button. reset I

« Firstmessage —
« Second message

a Third m o :I
Design | Sourcm

You are almost done. Next you add moving text to the page.

You have added an image to the input page and now you are ready to begin
[“Exercise 9.7: Adding moving text to the page.”]

Exercise 9.7: Adding moving text to the page

Before you begin, you must complete |“Exercise 9.6: Adding a picture to the page”|

To add moving text:
1. Back to the Design page, position the cursor underneath your company name.
2. Click Insert from the workbench menu.
3. Click Paragraph > Heading 3 on the pop-up menu.
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18]
WeE s

IBM Laboratory

# First message
+ Second message
+ Third message

4. Leave the cursor positioned inside the heading 3 frame.
5. Click Insert from the workbench menu.

Chapter 9. Module 9. Enhancing the input page using Web tools 133



@& Web - inquiry.jsp - lﬂM Rational Software Development Platform = |I:||3_§]
File Edit Toolbar J5P Format Table Frame Page Tools Mavigate Search Project Run  Window
Help 2 Link... cri+q
15 - = 4 Anchar... J e 1| @ web
|B r u & Image File | | B EBremote Syste...
Jlﬁ 5 J%. Background Image File r
Background Music 4 o
&
= Free Layout Table
inquiry. jsp - Custom
5 Text Cell
Paragraph
Lisk
[7] Table... Cri+T
~— Horizontal Rule
Form and Input Fields ¥
L 0 Seript
d
o |4 Layout Box
4 Line Ereak... Ctrl+Enter
o Special Characters...
Mon-breaking Space  Ctrl+Shift+Space
File...
Keyword... """'
' @Datemd'rm

« First messar Paqﬂermrate ¥
« Second mes  Web Site Navigation
+ Third message

[ e —
|

4|

Style Container (DIV)
| wsslabxxfwebContent/inquiry.jsp SPAN with Styls...

6. Click Others > Marquee on the pop-up menu
The Insert Marquee window opens.

@ Insert Marquee ﬁl

Text:

@ éber custorer number and press Submit biutton to start the a;:@'

~Eehavior —Repetition

Movement: . | Repettion:
Direction: |(Auto) - Cout; 0—

—Display speed —Size

Delay time: I Width: I |pixe|s LI
Scroll amount: 1 Height: ] Ipixels Z|

[~ Use true speed

—Color

Background color: [0 ¥ A= @ il
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7. Enter into the Text field Please enter customer number and press Submit
button to start application.

8. Select Slide from the Movement list.
9. Select Finite from the Repetition list.
10. Select 1 from the Count list.

The two last selections just avoid the text sliding in forever and not standing
still. If you want more movement on the page, you can change these settings.

11. Select Lime in the Background color list.
12. Click OK.
The Design page should look like:
To save some space, you can remove some of the line break tags.

13. Position the cursor on the BR tag.

RN i

inquiy.sp - Customer Inquiry * E) v | marquE]N~| | standard

|CE focused i

&0 ‘
WastAG
IBM Laboratory

L L £ Lt 4L

=

Design | Source | Preview |

14. Press the Delete key until the entry field and push buttons appear on your
page:
Next you view the page as it would appear in a browser.

15. Click the Preview tab at the bottom of the Design page.
You will notice that your heading 3 text is sliding in.
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inquiry.jsp - Customer Inguiry *

164

‘
IBM Laboratory

Yeinquiry.label_Enter_customer_number

%inguiry. button. submit | Yeinquiry. button. reset ]

« First message [;5
o Second message
« Third message

=
Design | Source |Preview |

You have added a marquee to the input page and now you are ready to begin
[“Exercise 9.8: Changing the text color.”]

Exercise 9.8: Changing the text color

Before you begin, you must complete [“Exercise 9.7: Adding moving text to the]
[page” on page 132

Sometimes you want to change the text color. There is an easy way to apply
another color to certain areas of text. To do that you return to the Design page.

To change the text color:
1. Click the Design tab.
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10.
11.

* m Laboratory

Design ISOI.I‘C& | Preview

#eoffon - 2| Text-CutrO

Set as Table Background Color
= e of Layout Box

Quick Edit ﬂas@wsrs | Console

Select the company text (IBM) you want to change color on, by swiping the
text area with the mouse cursor.

Below the Page Designer window there are several tabs.
Click the Colors tab.

If you don’t see the Colors tab, click Windows > Show View > Colors from
the Workbench menu.

Select a color from the Color palette.
Click Text color from the Color menu.
Click Set as Text Color on the pop-up menu.

You are done; now the selected text will be displayed with the color you
selected for it.

Click the Preview tab to view your completed page.
Save the file inquiry.jsp.

S - ]

inquiry.jsp - Customer Inquiry * PR )

%inguiry label Enter_customer_number

Design |Som:§@'

Exit Page Designer.
In the Project Explorer expand the WSSLABxx folder.
Expand the Web content folder.
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12. Right-click inquiry.jsp.
13. Click Run > Run on server on the pop-up menu.

Your new designed input page opens and you can run your Web application.

| attp:/localhost: 9080/ WS5LABxxfinguiry jsp sl e |2 @ed S| .

;M
wistitay = W

IBM Laboratory

-~

Enter custorner number:

Cone

You have applied color to certain areas of text on the input page.

Module recap

You have completed [Chapter 9, “Module 9. Enhancing the input page using Web)|
[tools,” on page 115)You have learned how to:

* Locate the Web application input page and start Page Designer
* View the title of the input page

* Add a style to the input page

* Preview the new style for the input page
 Start WebArt Designer

* Create a logo

* Resize the logo

* Save the object as a WebArt object

* Save the object for a Web page

¢ Place the object on the Design page

* Add a company name to the input page
* Add an image to the input page

* Add a marquee to the input page

* Apply color to certain areas of text

Finish your tutorial by reviewing the materials in [Chapter 10, “Summary,” on page|
139.
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Chapter 10. Summary

In this tutorial you learned how to create a simple e-business customer inquiry
application that used a Web-based front end to communicate with the business
logic written in ILE RPG residing on an iSeries server. While creating a browser
user interface, you used the iSeries Web Interaction wizard to generate input and
output JSP files as well as Page Designer to enhance the input and output Web
pages. You also added iSeries Web components to your pages, for example, Web
equivalents of iSeries command keys, input fields that accept only particular types
of data, or output fields such as subfile names. You then ran the application in the
WebSphere Test Environment that is part of the product.

Completed learning objectives

If you have completed all of the modules, you should now be able to:

¢ Use the Remote System Explorer perspective to edit and compile an iSeries
program or service program

* Use the Web perspective tools and views to create a Web project for your Web
application

* Create a Web interaction to use an input page and an output page and to create
a servlet to invoke an RPG program or service program to get data from the
iSeries

* Run the Web application in the WebSphere Test Environment

* Use service entry breakpoints to debug your Web application

* Create an informative error page for customers when an incorrect customer
number is entered

* Add color, pictures, change text to make the input page more attractive
More information

For more information on the product and the iSeries Web Tools, see
http:/ /ibm.com/software /adwtools/iseries.
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Appendix. Notices

Note to U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Lab Director

IBM Canada Ltd. Laboratory
8200 Warden Avenue
Markham, Ontario

Canada

L6G 1C7

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 1992, 2005. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks

IBM
iSeries
RPG/400
Rational
WebSphere

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

ActiveX, Microsoft, SourceSafe, Visual C++, Visual SourceSafe, Windows, Windows
NT®, Win32, Win32s and the Windows logo are trademarks of Microsoft
Corporation in the United States, other countries, or both.

UNIX® is a registered trademark of The Open Group.

Other company, product, and service names may be trademarks or service marks
of others.
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